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Iphone4 v͵n l¨ smartphone hot nhͫt thΠ tr̯γng 

iPhone v¨ c§c mӾu Ľi֓n thoӴi Android b§n t֝t ֫ ph©n kh¼c cao cӸp, trong khi tַ 5 tri֓u tr֫ xu֝ng, 

smartphone chӴy Symbian cֳa Nokia ĽҼ֯c kh§ch ch֙n nhiԚu. 

Giá Ľi֓n thoӴi th¹ng minh tr֫ n°n rԎ hҺn, c֥ng v֧i xu hҼ֧ng ngҼ֩i d½ng t³m kiԒm nhֻng mӾu Ľi֓n thoӴi 

h֣ tr֯ kԒt n֝i t֝t, nhiԚu t²nh nŁng Ľ« tŁng th֗ phӺn smartphone ֫ Vi֓t Nam. Theo nhiԚu cֹa h¨ng l֧n, c§c 

mӾu smartphone thiԒt kԒ ĽԌp, gi¨u t²nh nŁng giӶi tr², ĽԊc bi֓t m¨n h³nh cӶm ֵng th֩i trang ng¨y c¨ng 

ĽҼ֯c t³m mua nhiԚu. 

iPhone Ľang l¨m chֳ ph©n kh¼c smartphone x§ch tay cao cӸp, ngo¨i ra, ph©n kh¼c n¨y h¨ng Android cֳa 

HTC, Samsung cȈng b§n t֝t. Trong khi Ľ·, c§c model chӴy nԚn tӶng Google cֳa Motorola, LG hàng công 

ty cȈng kh§ "h¼t kh§ch". 

D̯αi Ľ©y l¨ danh s§ch 10 chiΔc ĽiΜn thoͧi th¹ng minh b§n tΧt nhͫt, tΫng hιp cͩ hai thΠ tr̯γng x§ch tay 

và chính hãng. 

iPhone 4 16GB 

http://vietcntt.com/news/dien-thoai,gia-iphone-4-gan-cham-3gs-16678.html


 

So v֧i bӶn 32GB qu֝c tԒ, model 16GB ĽҼ֯c nhiԚu ngҼ֩i ch֙n mua, b֫i mֵc gi§ thӸp hҺn gӺn 2 tri֓u 
Ľ֟ng. Sֵc mua cֳa iPhone 4 tŁng mӴnh trong khoӶng nֹa th§ng tr֫ lӴi Ľ©y khi gi§ xu֝ng. 

iPhone 4 l¨ mӾu di Ľ֥ng m֧i nhӸt tַ Apple, m§y c· thiԒt kԒ m֛ng, m¨n h³nh Ľ֥ n®t cao, camera quay 

phim HD. Ngo¨i ra, v֧i t֝c Ľ֥ xֹ lĨ 1GHz, chӴy iOS 4 nhiԚu t²nh nŁng, iPhone 4 hӸp dӾn ngҼ֩i mua. 

HTC Desire 

 

ThiԒt kԒ cֳa Desire kh¹ng ĽԌp nhҼ Xperia X10 hay iPhone, nhҼng v֧i t֝c Ľ֥ 1GHz, hi֓u nŁng mӴnh, 

trang b֗ nhiԚu t²nh nŁng tr°n nԚn Android, Ľ©y l¨ chiԒc di Ľ֥ng c· doanh s֝ t֝t tr°n cӶ hai th֗ trҼ֩ng x§ch 

tay lӾn ch²nh h«ng. 

Desire s֫ hֻu m¨n h³nh AMOLED r֥ng v¨ rֽc r֭, r֥ng 3,7 inch, vi xֹ lĨ t֝c Ľ֥ 1GHz, RAM 576MB, 

ROM 512 MB. M§y t²ch h֯p GPS, Wi-Fi, Bluetooth. 

http://vietcntt.com/news/dien-thoai,ngam-htc-desire-hd-16032.html


iPhone 3GS 16GB 

 

BӶn iPhone 3GS 16GB cȈng c· doanh s֝ t֝t, mԊc d½ h¨ng c§c model m֧i Ľang giӶm gi§ mӴnh. Hi֓n tӴi, 

bӶn qu֝c tԒ model n¨y Ľang ĽҼ֯c b§n ֫ mֵc 13,5 tri֓u Ľ֟ng. 

iPhone 3GS ra mԂt nŁm ngo§i, l¨ chiԒc di Ľ֥ng c· thiԒt kԒ mӶnh mai, cӸu h³nh trung b³nh nhֻng chӴy 

mҼ֯t m¨. M§y kh¹ng c· nhiԚu trang b֗ nhҼ iPhone 4, tuy nhi°n khӶ nŁng xֹ lĨ c§c t§c vֱ, lҼ֧t web tuy֓t 

v֩i. Model n¨y hi֓n Ľ« c· t²nh nŁng Ľa nhi֓m tr°n nԚn iOS 4. 

HTC Legend 

 

C½ng v֧i Desire, Legend ĽҼ֯c kh§ch h¨ng mua nhiԚu tr°n ph©n kh¼c x§ch tay. ChiԒc di Ľ֥ng cֳa HTC c· 

thiԒt kԒ nh¹m kh֝i th֩i trang, m¨n h³nh AMOLED rֽc r֭ v¨ giao di֓n Sense ti֓n sֹ dֱng. 

Legend kh¹ng c· cӸu h³nh mӴnh nhҼ Desire, b½ lӴi gi§ m§y t֝t hҺn, ngo¨i ra, khӶ nŁng xֹ lĨ, kԒt n֝i cֳa 

model n¨y ֡n Ľ֗nh. 

Motorola Milestone 

http://vietcntt.com/news/may-tinh-xach-tay,htc-legend--chiec-smartphone-nhom-khoi-giong-thiet-ke-cua-apple-13065.html
http://vietcntt.com/news/dien-thoai,mot-vai-cam-nhan-ve-motorola-milestone-xt720-15447.html


 

Milestone l¨ mӾu Android ĽҼ֯c Ľ§nh gi§ cao vԚ khӶ nŁng xֹ lĨ lӾn gi§ t֝t. Hi֓n thiԒt b֗ ĽҼ֯c b§n dҼ֧i 10 

tri֓u Ľ֟ng, m§y c· thiԒt kԒ m֛ng, b¨n ph²m QWERTY trҼ֯t, m¨n h³nh 3,7 inch r֥ng r«i. Milestone lҼ֧t 

web v¨ chӴy c§c ֵng dֱng mҼ֯t m¨. 

Samsung Wave 

 

Wave S8500 vַa hӴ gi§ m֥t tri֓u Ľ֟ng v¨ l¨ chiԒc smartphone "ch§y h¨ng" tӴi nhiԚu Ľ֗a ch֕. S8500 l¨ 

chiԒc di Ľ֥ng ĽӺu ti°n chӴy tr°n h֓ ĽiԚu h¨nh Samsung Bada, nԚn tӶng ĽҼ֯c h«ng c¹ng b֝ tַ cu֝i nŁm 

ngo§i. Model n¨y s֫ hֻu m¨n h³nh Super AMOLED, t֝c Ľ֥ 1GHz v¨ c§c t²nh nŁng hҼ֧ng t֧i giӶi tr², kԒt 

n֝i. 

Nokia E72 

http://vietcntt.com/news/dien-thoai,samsung-chinh-thuc-gioi-thieu-wave-2-va-wave-2-pro-14984.html
http://vietcntt.com/news/dien-thoai,tren-tay-nokia-e5-xach-tay-16361.html


 

KԒ tֱc E71, Nokia E72 l¨ chiԒc smartphone tӺm trung b§n t֝t cֳa Nokia. M§y trang b֗ kԒt n֝i HSUPA, 

h֣ tr֯ tӶi dֻ li֓u l°n nhanh hҺn b°n cӴnh giԂc cԂm tai nghe 3,5 mm cho ph®p ngҼ֩i d½ng chҺi nhӴc v֧ 

nhiԚu loӴi headphone hҺn. 

LG GT540 Optimus 

 

LG GT540 Optimus c· kiԜu d§ng ĽԌp v¨ g֙n. MԊt trҼ֧c cֳa m§y l¨ m¨n h³nh cӶm ֵng Ľi֓n tr֫ TFT r֥ng 

3 inch, Ľ֥ ph©n giӶi 320 x 480 pixel, h֣ tr֯ tֽ Ľ֥ng xoay. M§y trang b֗ kԒt n֝i 3G/HSDPA 7.2 Mb/gi©y, 

Wi-Fi, GPS, camera 3,2 Megapixel, tֽ Ľ֥ng cӴnh n®t, nhԀn dӴng khu¹n mԊt. 

M§y chӴy tr°n h֓ ĽiԚu h¨nh Android 1.6, t²ch h֯p c§c ֵng dֱng mӴng x« h֥i nhҼ Facebook, Twitter, chҺi 

nhӴc, xem phim. Model n¨y c· giԂc cԂm tai nghe 3,5 mm, khe cԂm thԎ nh֧ cho ph®p m֫ r֥ng t֧i 32GB 

Nokia E63 

http://vietcntt.com/news/dien-thoai,cham-diem-cho-smartphone-lg-optimus-gt540-15946.html
http://www.vietcntt.com/news/dien-thoai,nokia-e63-ban-rut-gon-cua-e71-7882.html


 

E63 b§n ra hҺn m֥t nŁm, nhҼng vӾn l¨ thiԒt b֗ ĽҼ֯c nhiԚu kh§ch h¨ng lֽa ch֙n. M§y c· b¨n ph²m 
QWERTY, h֣ tr֯ kԒt n֝i 3G, Wi-Fi v¨ c§c t²nh nŁng cҺ bӶn d¨nh cho ngҼ֩i d½ng m֧i. 

Nokia 5233 

 

Nokia 5233 ĽҼ֯c xem l¨ "quӶ bom" gi§ rԎ cֳa nh¨ sӶn xuӸt PhӺn Lan, cӴnh tranh v֧i c§c Ľ֝i thֳ tַ 

Samsung, LG kh¹ng c· h֓ ĽiԚu h¨nh. M§y c· thiԒt kԒ kh¹ng kh§c 5230, m§y chӴy tr°n h֓ ĽiԚu h¨nh 

Symbian S60 phi°n bӶn 5, m¨n h³nh cӶm ֵng Ľi֓n tr֫ r֥ng 3,2 inch, Ľ֥ ph©n giӶi 360 x 640 pixel. ņ§ng 

tiԒc, model n¨y kh¹ng h֣ tr֯ Wi-Fi, GPS, 3G. 

 

(Theo SH ) 

M֥t tri֓u Samsung Wave Ľ« b§n ֫ ch©u Ąu 

http://vietcntt.com/news/may-tinh-xach-tay,di-dong-cam-ung-nokia-28-trieu-dong-tai-vn-13583.html
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Wave S8500 l¨ chiΔc smartphone Bada Ľͭu ti°n. ͨnh: 

QuΧc Huy. 

Samsung vַa th¹ng b§o, h«ng Ľ« b§n ĽҼ֯c m֥t tri֓u Wave S8500 ch֕ ri°ng ֫ ch©u Ąu, th§ng 7 vַa r֟i, 

model n¨y Ľ« ĽӴt doanh s֝ m֥t tri֓u tr°n to¨n thԒ gi֧i. 

Samsung Wave l¨ chiԒc smartphone ĽӺu ti°n cֳa Samsung chӴy tr°n nԚn Bada, model c· thiԒt kԒ ĽԌp, cӸu 

h³nh mӴnh v¨ khӶ nŁng xֹ lĨ t֝t. TӴi ch©u Ąu, m§y c§n Ľ²ch m֥t tri֓u m§y sau 4 th§ng c· mԊt tr°n th֗ 

trҼ֩ng. 

Th§ng 7 vַa r֟i, model n¨y Ľ« ĽӴt m֥t tri֓u m§y, nhҼng ֫ quy m¹ to¨n thԒ gi֧i. Hi֓n h«ng chҼa c¹ng b֝ 

con s֝ tiԒp theo. Nh¨ sӶn xuӸt Ľang c· kԒ hoӴch ĽҼa Wave vԚ qu° hҼҺng v¨o cu֝i nŁm nay, hi֓n th֗ 

trҼ֩ng H¨n Qu֝c vӾn chҼa b§n m§y. 

Wave S8500 n֡i bԀt v֧i m¨n h³nh Super AMOLED r֥ng 3,3 inch, kԒt n֝i Wi-Fi, GPS, camera 5 

Megapixel h֣ tr֯ quay phim HD. 

Hi֓n tӴi, nԚn tӶng Bada Ľ« c· th°m 3 model g֟m Wave 2, Wave 2 Pro và Wave 723. 

 

(Theo SH ) 

MԌo giӸu Ľ֗a ch֕ trong Favorites 

22.09.2010 21:14 



 

BӴn sҼu tӺm ĽҼ֯c m֝t s֝ Ľ֗a ch֕ Ҽng Ĩ v֧i nhiԚu n֥i dung hay, b֡ ²ch trong khi lҼ֧t web, bӴn nghǫ c· thԜ 

gi¼p ²ch cho bӴn rӸt nhiԚu trong h֙c tԀp v¨ c¹ng vi֓c. L¼c n¨y ĽiԚu ĽӺu ti°n bӴn nghǫ ra l¨ lҼu c§c Ľ֗a ch֕ 

Ľ· v¨o Favorites ĽԜ c· thԜ thuԀn ti֓n cho nhֻng lӺn m֫ xem tiԒp theo. NhҼng ĽiԚu kh· khŁn l¨ bӴn mu֝n 

m֥t m³nh Ľ֥c quyԚn s֫ hֻu nhֻng Ľ֗a ch֕ Ľ· kh¹ng mu֝n ngҼ֩i kh§c biԒt v¨ click chu֥t v¨o m֣i khi 

truy cԀp Internet. Ch֕ c¸n c§ch l¨ l¨m thԒ n¨o ĽԜ giӸu n· Ľi v¨ ch֕ m³nh m֧i c· thԜ nh³n thӸy v¨ m֫ n· 

lên. 

H«y thֹ v֧i chҼҺng tr³nh Hide My Favorites, n· sԐ cho ph®p bӴn giӸu bӸt kȢ Ľ֗a ch֕ n¨o trong Favorites 

v¨ hҺn nֻa c¸n c· m֥t chֵc nŁng bӶo v֓ bԄng mԀt khӼu, nԒu bӴn l¨ ngҼ֩i ĽԊt mԀt khӼu bӶo v֓ th³ bӴn 

h«y y°n t©n v³ ch֕ c· bӴn l¨ ngҼ֩i m֧i c· thԜ cho hi֓n ra c§c Ľ֗a ch֕ Ľ· m¨ th¹i, thԀm ch² tַ trong chҼҺng 

tr³nh, bӴn vӾn c· thԜ x·a, Ľ֡i t°n c§c Ľ֗a ch֕ hay m֫ thԆng c§c trang web tַ nhֻng Ľ֗a ch֕ Ľ·. BӴn tӶi vԚ 

tӴi Ľ֗a ch֕: http://www.softforall.com/Internet/OnlinePrivacy/Hide_My_Favorites06110038.htm. 

 

Sau khi c¨i ĽԊt v¨ k²ch hoӴt chҼҺng tr³nh, mu֝n tiԒn h¨nh giӸu Ľ֗a ch֕ th³ ĽӺu ti°n bӴn phӶi Ľ·ng tr³nh 

duy֓t web trҼ֧c, sau Ľ· ch֙n Ľ֗a ch֕ cӺn giӸu r֟i bӸm n¼t Hide l¼c n¨y Ľ֗a ch֕ n¨o b֗ giӸu th³ sԐ chuyԜn 

sang c· m¨u Ľ֛. BӴn mu֝n Ľ֡i t°n, bӸm n¼t Rename; ĽԜ m֫ trang web tַ Ľ֗a ch֕ Ľ·, bӸm n¼t Launch 

Favorites; c¸n mu֝n xo§ th³ bӸm n¼t Delete. Mu֝n bӶo mԀt Ľ֗a ch֕ ֫ mֵc Ľ֥ cao nhӸt bӴn c· thԜ ĽԊt m֥t 

khӼu bԄng c§ch bӸm n¼t Change Password, tr°n cֹa s֡ bӴn nhԀp Password theo y°u cӺu r֟i bӸm Ok. 

 

Khi n¨o cӺn cho hi֓n lӴi c§c Ľ֗a ch֕ ĽԜ truy cԀp, bӴn k²ch hoӴt lӴi chҼҺng tr³nh n¨y, ch֙n Ľ֗a ch֕ cӺn cho 

hi֓n lӴi r֟i bӸm n¼t Unhide (n¼t Hide khi Ӽn). 

 

LҼu Ĩ: TrҼ֩ng h֯p Ľ֗a ch֕ n¨o Ľ« ĽҼ֯c bӶo v֓ bԄng mԀt khӼu th³ cȈng v¨o Change Password g» Ľ¼ng 

mԀt khӼu Ľ« nhԀp m֧i c· thԜ m֫ ĽҼ֯c.  

 

(Theo XHTT ) 

ņiԚu ch֕nh ©m lҼ֯ng bԄng b§nh lŁn chu֥t 

21.09.2010 19:18 

http://www.softforall.com/Internet/OnlinePrivacy/Hide_My_Favorites06110038.htm


 

BӴn thҼ֩ng nghe nhӴc m֣i khi d½ng m§y t²nh, m֣i lӺn mu֝n tŁng giӶm ©m lҼ֯ng cֳa bӶn nhӴc Ľang ph§t 

bӴn phӶi dַng c¹ng vi֓c cֳa m³nh lӴi v¨ m֫ Volume control cֳa Windows hoԊc chҼҺng tr³nh chҺi nhӴc 

ĽԜ ĽiԚu ch֕nh, hoԊc phӶi nho¨i ngҼ֩i ĽԒn ĽiԚu ch֕nh n¼t volume tr°n h֓ th֝ng loa. C· m֥t c§ch gi¼p bӴn 

ch֕ cӺn xoay b§nh lŁn cֳa chu֥t Ľang cӺm trong tay l¨ c· thԜ ĽiԚu ch֕nh ©m lҼ֯ng ĽҼ֯c r֟i, Ľ· l¨ sֹ dֱng 

chҼҺng tr³nh mi֑n ph² Volumouse. 

 

ChҼҺng tr³nh sԐ cho ph®p bӴn x§c lԀp m֥t quy luԀt khi bӴn quay b§nh lŁn chu֥t kԒt h֯p v֧i m֥t Ľ֥ng t§c 

g³ Ľ· th³ sԐ c· thԜ thay Ľ֡i ©m lҼ֯ng cֳa h֓ th֝ng. ChԆng hӴn khi bӴn bӸm ph²m Alt v¨ quay b§nh lŁn 

chu֥t, hay giֻ chu֥t tr§i v¨ quay b§nh lŁn chu֥t, hoԊc khi con tr֛ chu֥t nԄm tr°n taskbar v¨ quay b§nh 

lŁn th³ sԐ c· thԜ thay Ľ֡i ©m lҼ֯ng h֓ th֝ng. Khi nhֻng ĽiԚu ki֓n ĽҼ֯c qui Ľ֗nh trҼ֧c kh¹ng ĽҼ֯c th»a 

m«n th³ b§nh lŁn chu֥t sԐ tr֫ lӴi v֧i t²nh nŁng b³nh thҼ֩ng. 

 

Kh¹ng ch֕ c· thԒ, chҼҺng tr³nh c¸n c· thԜ thay Ľ֡i Ľ֥ trong su֝t cֳa m֥t cֹa s֡ v¨ Ľ֥ s§ng t֝i cֳa m¨n 

hình. 

 

Y°u cӺu h֓ th֝ng: 

 

- C§c hΜ ĽiΖu h¨nh Windows 32 bit tρ Windows 98 trε l°n. 

- Chuίt c· b§nh xe lŁn. 

- Sound card. 

 

TӶi vԚ v¨ c¨i ĽԊt: 

 

TӶi vԚ tԀp tin volumouse.zip mi֑n ph² tַ Ľ֗a ch֕: http://www.nirsoft.net/utils/volumouse.zip. Sau Ľ· 

giӶi n®n v¨ bӸm Ľ¹i v¨o tԀp tin volumouse.exe ĽԜ chӴy chҼҺng tr³nh. HoԊc c· thԜ tӶi vԚ tԀp tin c¨i ĽԊt tӴi 

Ľ֗a ch֕: http://www.nirsoft.net/utils/volumouse_setup.exe v¨ tiԒn h¨nh c¨i ĽԊt b³nh thҼ֩ng, sau Ľ· chӴy 

chҼҺng tr³nh tַ Start menu ĽԜ sֹ dֱng. 

 

Sֹ dֱng: 

 

- ֪ giao di֓n ch²nh cֳa chҼҺng tr³nh, mֱc Mixer Device bӴn ch֙n Default Playback Device in Control 

Panel. 

 

TiԒp theo ֫ phӺn Wheel Mouse Rules, mֱc Use the wheel when, bӴn bӸm v¨o mȈi t°n x֡ xu֝ng, m֫ ra 

danh s§ch c§c kiԜu t½y ch֙n ĽԜ kԒt h֯p v֧i vi֓c lŁn b§nh xe chu֥t trong vi֓c thay Ľ֡i ©m lҼ֯ng. 

http://www.nirsoft.net/utils/volumouse.zip
http://www.nirsoft.net/utils/volumouse_setup.exe


 

 

ChԆng hӴn nhҼ Left mouse button is down c· nghǫa l¨ khi bӴn bӸm giֻ chu֥t tr§i v¨ lŁn b§nh xe chu֥t th³ 

©m lҼ֯ng sԐ thay Ľ֡i, Alt key is down nghǫa l¨ bӸm giֻ ph²m Alt, Mouse cursor is over the taskbar l¨ khi 

ĽҼa con tr֛ chu֥t ĽԒn thanh taskbar... 

 

Mֱc Component tҼҺng ֵng c½ng h¨ng v֧i t½y ch֙n Ľ·, bӴn ch֙n Volume Control ĽԜ thay Ľ֡i ©m lҼ֯ng. 

Mֱc Channel ĽԜ mԊc Ľ֗nh l¨ All Channels (t§c dֱng l°n tӸt cӶ c§c k°nh ©m thanh - tr§i v¨ phӶi). Mֱc 

Steps l¨ mֵc Ľ֥ thay Ľ֡i ©m lҼ֯ng khi bӴn lŁn m֥t v¸ng b§nh xe, bӴn ĽԜ mԊc Ľ֗nh l¨ 1000. 

 

֪ phӺn General Options, bӴn c· thԜ lֽa ch֙n Ľ§nh dӸu kiԜm v¨o mֱc Display icon in the system tray ĽԜ 

ĽԊt biԜu tҼ֯ng cֳa chҼҺng tr³nh l°n khay h֓ th֝ng, mֱc Load Volumouse at startup ĽԜ chҼҺng tr³nh kh֫i 

Ľ֥ng c½ng Windows, Display this window when you start Volumouse ĽԜ cֹa s֡ Options hi֓n l°n l¼c m֫ 

chҼҺng tr³nh v¨ Run Volumouse application in high priority ĽԜ x§c lԀp mֵc Ҽu ti°n cao cho chҼҺng tr³nh. 

 

Cu֝i c½ng bӸm OK ĽԜ chҼҺng tr³nh bԂt ĽӺu thֽc thi. BӴn h«y kԒt h֯p vi֓c lŁn b§nh xe chu֥t v֧i m֥t 

chֵc nŁng Ľ« ĽҼ֯c thiԒt lԀp ֫ tr°n ĽԜ thӸy kԒt quӶ. ņԜ tho§t kh֛i hԆn chҼҺng tr³nh, bӴn bӸm phӶi l°n biԜu 

tҼ֯ng chҼҺng tr³nh tr°n taskbar v¨ ch֙n Exit completely. 

 

Ngo¨i ra, Ľ֝i v֧i h֓ ĽiԚu h¨nh Windows 2000 hoԊc Windows XP th³ bӴn c¸n c· thԜ thay Ľ֡i Ľ֥ trong su֝t 

caֳ m֥t cֹa s֡. ņԜ l¨m ĽiԚu n¨y, bӴn cȈng thֽc hi°n tҼҺng tֽ nhҼ tr°n nhҼng ֫ mֱc Component trong 

Volumouse Options, h«y ch֙n Window Transparency thay v³ Volume Control. Sau Ľ· bӴn m֫ cֹa s֡ 

mu֝n thay Ľ֡i Ľ֥ trong su֝t, kԒt h֯p lŁn b§nh xe v֧i m֥t trong c§c t½y ch֙n ĽԜ thay Ľ֡i. TҼҺng tֽ nԒu 

bӴn mu֝n thay Ľ֡i Ľ֥ s§ng t֝i cֳa m¨n h³nh th³ ch֙n Screen Brightness trong mֱc Component... 

 

(Theo LÝ ANH BÌNH - lybinhus@yahoo.com | KHPT ) 

D֗ch vֱ chia sԎ file kh¹ng hӴn chԒ 

21.09.2010 19:15 



 

Tuy ch֕ l¨ em ¼t so v֧i nhֻng d֗ch vֱ chia sԎ thu֥c h¨ng ĽӴi gia nhҼ RapidShare, MegaUpload... nhҼng 

MediaFire lӴi c· nhֻng Ҽu ĽiԜm m¨ ²t d֗ch vֱ n¨o trҼ֧c Ľ· c· ĽҼ֯c: 

 

- File Ľ̯ιc l̯u trυ vǫnh viΚn tr°n m§y chν. 

- TΧc Ľί download, upload dυ liΜu rͫt nhanh vαi nhiΖu file c½ng lúc. 

- Hέ trι upload mΣi loͧi file vαi k²ch th̯αc kh¹ng hͧn chΔ, kh¹ng giαi hͧn bŁng th¹ng. 

- Ng̯γi sσ dλng c· thΘ download ngay lͻp tοc m¨ kh¹ng mͫt thγi gian chγ hay nhͻp m« x§c nhͻn. Cho 

ph®p tͩi vΖ b΄ng c§c ch̯̭ng tr³nh download chuy°n dλng. 

- Chia sΐ Ľ̯γng d͵n tͩi file qua email, AIM, Y!M. 

 

CĆCH Sָ DְNG: 

 

- Truy cԀp v¨o Ľ֗a ch֕ http://www.mediafire.com. BӸm v¨o Create a Free Account ֫ g·c phӶi ĽԜ ĽŁng kĨ 

m֥t t¨i khoӶn mi֑n ph². BӴn nhԀp v¨o Ľ֗a ch֕ email, mԀt khӼu r֟i bӸm n¼t Create a Free Account. Khi c· 

x§c nhԀn ĽŁng kĨ th¨nh c¹ng, bӸm OK. 

 

- Trong mֱc I want to upload, ch֙n s֝ file mu֝n upload (t֝i Ľa 10 file). BӸm n¼t Browse... v¨ ch֙n file 

bӴn cӺn upload. Cu֝i c½ng bӸm n¼t Upload File To MediaFire. BӴn c· thԜ theo d»i qu§ tr³nh upload th¹ng 

qua mֱc Uploading Files (t֝c Ľ֥, th֩i gian, dung lҼ֯ng). Sau khi xong, MediaFire sԐ cung cӸp c§c th¹ng 

tin li°n quan ĽԒn dֻ li֓u vַa ĽҼa l°n bao g֟m: Download Link (ĽҼ֩ng dӾn tӶi file), HTML Link Code 

(ch¯n ĽҼ֩ng dӾn tӶi file v¨o trang web html), Forum Link Code (ch¯n ĽҼ֩ng dӾn tӶi file v¨o c§c di֑n 

Ľ¨n). Ngo¨i ra bӴn c· thԜ gֹi ĽҼ֩ng dӾn tӶi file cho ngҼ֩i kh§c qua email (Email this file) hay Y!M 
(Yahoo Messenger buddy). 

 

- Trong tab My Files sԐ th֝ng k° to¨n b֥ nhֻng file bӴn Ľ« upload. NԒu mu֝n x·a file n¨o bӴn bӸm v¨o 

biԜu tҼ֯ng h³nh tr¸n m¨u Ľ֛ trong c֥t Delete. 

 

(Theo HOêNG NGHǪA HͦNH - hanhdb@gmail.com | KHPT ) 

ChuyԜn Ľ֡i trֽc tuyԒn nhiԚu dӴng file tӴi Media-Convert 
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Media-Convert (MC) l¨ m֥t ֵng dֱng web Ľ֥c Ľ§o, cho ph®p ngҼ֩i d½ng chuyԜn Ľ֡i Ľ֗nh dӴng trֽc 

tuyԒn hӺu hԒt c§c loӴi file ph֡ biԒn nhӸt hi֓n nay, tַ vŁn bӶn, file n®n, Ӷnh, phim cho ĽԒn nhӴc s֝ v֧i 

dung lҼ֯ng ĽԒn 50 MB. һu ĽiԜm r» n®t nhӸt cֳa MC l¨ kh¹ng cӺn c¨i ĽԊt phӺn mԚm, kh¹ng phӶi ĽŁng kĨ 

t¨i khoӶn, t֝c Ľ֥ chuyԜn Ľ֡i nhanh ch·ng, sֹ dֱng d֑ d¨ng, h֣ tr֯ v¹ s֝ c§c Ľ֗nh dӴng file v¨ ĽԊc bi֓t l¨ 

ho¨n to¨n mi֑n ph². 

 

BӴn c¸n c· thԜ chia sԎ file d֑ d¨ng v¨ nhanh ch·ng ĽԒn m֙i ngҼ֩i th¹ng qua Ľ֗a ch֕ URL, thay v³ phӶi 

Ľ²nh kèm chúng qua e-mail hoԊc phӶi upload tr°n c§c d֗ch vֱ chia sԎ dֻ li֓u trֽc tuyԒn. 

 

ņԜ khai th§c MC, trҼ֧c ti°n, bӴn h«y truy cԀp trang chֳ cֳa d֗ch vֱ tӴi Ľ֗a ch֕ http://media-

convert.com. BӸm l°n n¼t Browse... trong v½ng How to convert a file, t³m ĽԒn Ľ֗a ĽiԜm lҼu trֻ cֳa file 

m¨ bӴn mu֝n chuyԜn Ľ֡i, bӸm l°n biԜu tҼ֯ng cֳa n·, ch֙n mֱc Open, ch֙n chuӼn Ľ֗nh dӴng xuӸt mong 

mu֝n tַ danh s§ch li֓t k° trong v½ng Output format, Ľ§nh dӸu kiԜm trҼ֧c t½y ch֙n I accept the terms, 

bӸm l°n n¼t Convert r֟i bӸm l°n n¼t OK trong v½ng Conversion options ĽԜ tiԒp tֱc. 

 

ņԜ tӶi file vַa ĽҼ֯c chuyԜn Ľ֡i Ľ֗nh dӴng th¨nh c¹ng vԚ m§y t²nh cֳa m³nh, bӴn h«y bӸm l°n n¼t 

Download nԄm b°n dҼ֧i d¸ng th¹ng b§o File successful converted, bӸm l°n n¼t Save khi xuӸt hi֓n h֥p 

thoӴi File Download, ĽԊt t°n v¨ x§c lԀp Ľ֗a ĽiԜm lҼu trֻ cho file sԂp ĽҼ֯c tӶi vԚ r֟i bӸm l°n n¼t Save ĽԜ 

ho¨n tӸt. NԒu mu֝n chuyԜn Ľ֡i file hi֓n h¨nh sang m֥t Ľ֗nh dӴng kh§c, h«y bӸm l°n n¼t Make another 

conversion of the file. HoԊc ch֙n mֱc Convert another file ĽԜ xֹ lĨ m֥t file kh§c. 

 

BӴn cȈng c· thԜ sֹ dֱng MC ĽԜ xֹ lĨ nhֻng file tr°n web bԄng c§ch Ľ§nh dӸu ch֙n trҼ֧c mֱc URL trong 

v½ng How to convert a file, nhԀp v¨o Ľ֗a ch֕ URL tҼҺng ֵng cֳa n· trong ¹ tr֝ng nԄm ngay cӴnh r֟i thֽc 

hi֓n c§c thao t§c c¸n lӴi tҼҺng tֽ nhҼ tr°n. 

 

BӴn c· thԜ d½ng link ĽҼ֯c cung cӸp trong mֱc Use the URL ĽԜ chia sԎ file vַa ĽҼ֯c chuyԜn Ľ֡i th¨nh 

c¹ng v֧i bӴn b¯ (c· gi§ tr֗ trong 6 ng¨y), gi֝ng nhҼ Ľ« upload l°n m֥t d֗ch vֱ chia sԎ dֻ li֓u trֽc tuyԒn 

n¨o ĽӸy. 

 

(Theo Lą NGUYΙN BͨO NGUYąN - baonguyen10101976@gmail.com | K ) 

TӴo file mp3 ph§t ©m b¨i h֙c sinh ngֻ 

21.09.2010 19:07 
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Text to Speech Maker l¨ phӺn mԚm gi¼p bӴn tӴo ra file ©m thanh c· Ľ֗nh dӴng wav, mp3, vox tַ m֥t tԀp 

tin text tiԒng Anh. BӴn c· thԜ d½ng file n¨y tr°n m§y MP3 hoԊc ĽҼa v¨o c§c thiԒt b֗ di Ľ֥ng ĽԜ nghe lӴi 

m֙i l¼c m֙i nҺi. ChҼҺng tr³nh c· dung lҼ֯ng dung lҼ֯ng 8.09MB, download tӴi Ľ֗a ch֕: 

http://w ww.xrlly.com/text-to-speech.htm 
 

BӴn c· thԜ c¨i ĽԊt th°m gi֙ng Ľ֙c cֳa Microsoft Mary v¨ Microsoft Mike v֧i tԀp tin XP Voice, download 

tӴi http://www.xrlly.com/download/XPVoice.msi. 

 

Sau khi c¨i ĽԊt xong, kh֫i Ľ֥ng Text to Speech Maker, ch֙n thԎ Text file, nhԀp n֥i dung b¨i h֙c v¨o. Khi 

nhԀp xong bӸm n¼t Options, bӸm n¼t c· biԜu tҼ֯ng chiԒc k²nh l¼p ֫ cu֝i ¹ Path. Ch֙n thҼ mֱc sԐ lҼu c§c 

tԀp tin ĽҼ֯c tӴo ra tַ chҼҺng tr³nh, ch֙n m֥t trong ba Ľ֗nh dӴng WAV, MP3, VOX trong phӺn Output 

Format, ĽiԚu ch֕nh thanh trҼ֯t Reading Speed vԚ b°n tr§i nԒu mu֝n t֝c Ľ֥ Ľ֙c chԀm v¨ ngҼ֯c lӴi nԒu 

mu֝n Ľ֙c nhanh, bӸm n¼t OK. 

 

BӸm n¼t Convert ĽԜ chuyԜn Ľ֡i n֥i dung b¨i h֙c th¨nh file ©m thanh. Ch֩ cho qu§ tr³nh chuyԜn Ľ֡i ho¨n 

tӸt th³ v¨o menu File > Save As ĽԜ lҼu n֥i dung b¨i h֙c th¨nh tԀp tin text ĽԜ ti֓n sֹ dֱng vԚ sau. 

 

D½ng Windows Media Player 10 ĽԜ luy֓n ph§t ©m. ņҼҺng nhi°n WMP 10 sԐ chҺi ĽҼ֯c tԀp tin n¨y kh¹ng 

c· g³ l¨ kh· khŁn, nhҼng ĽiԚu d§ng n·i ֫ Ľ©y l¨ ta c· thԜ l֯i dֱng ti֓n ²ch Advanced Tag Editor trong 

tr³nh chҺi nhӴc n¨y ĽԜ l¨m hiԜn th֗ tַng c©u trong n֥i dung b¨i h֙c su֝t qu§ tr³nh ph§t ĽԜ ti֓n theo d»i. 

C§ch thֽc hi֓n nhҼ sau: Kh֫i Ľ֥ng WMP 10, v¨o menu File Open, ch֙n tԀp tin ©m thanh vַa ĽҼ֯c tӴo ra 

tַ Text to Speech Maker, bӸm n¼t dַng ĽԜ WMP tӴm ngҼng hoӴt Ľ֥ng. Ch֙n thԎ Library, bӸm chu֥t phӶi 

l°n t°n cֳa file ©m thanh, ch֙n Advanced Tag Editor. Khi thӸy h֥p thoӴi Advanced Tag Editor xuӸt hi֓n, 

ch֙n thԎ Lyrics, bӸm n¼t Add, bӸm n¼t Synchronized Lyrics r֟i tiԒn h¨nh tӴo c©u ph§t ©m cho b¨i h֙c. 

 

Sau khi ho¨n tӸt, bӴn Ľ·ng tӸt cӶ c§c h֥p thoӴi, quay vԚ v֧i cֹa s֡ WMP v¨o menu Play > Captions and 

Subtitles, ch֙n On if Available. B©y gi֩ h«y bӸm n¼t Play ĽԜ bԂt ĽӺu, bӴn sԐ thӸy n֥i dung cֳa b¨i h֙c 

hi֓n ra theo gi֙ng Ľ֙c. 

 

(Theo TUͪN HUY - huylienpham@yahoo.ca | KHPT ) 

Tr²ch tַng khung h³nh tַ file video 
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NhiԚu chҼҺng tr³nh play video c· chֵc nŁng chֱp m¨n h³nh ra th¨nh file Ӷnh, nhҼng thҼ֩ng th³ thao t§c 

kh· khŁn (bӴn phӶi canh chַng khung h³nh Ҽng Ĩ xuӸt hi֓n ĽԜ bӸm v¨o n¼t chֱp) v¨ h³nh Ӷnh cho ra Ľ¹i 

khi b֗ nh¸e. 

 

NԒu Ľ©y l¨ c¹ng vi֓c bӴn thҼ֩ng l¨m th³ Free Video to JPG Converter sԐ l¨ m֥t lֽa ch֙n t֝t nhӸt, v³ 

chҼҺng tr³nh vַa mi֑n ph², c§ch sֹ dֱng d֑ d¨ng, lӴ, vַa c· rӸt nhiԚu lֽa ch֙n cho ph®p bӴn t§ch bӸt cֵ 

khung h³nh n¨o bӴn mu֝n, t֝c Ľ֥ l¨m vi֓c rӸt nhanh. Ngo¨i ra, c· thԜ d½ng chҼҺng tr³nh nhҼ m֥t c¹ng cֱ 

play tӸt cӶ c§c Ľ֗nh dӴng video. ChҼҺng tr³nh h֣ tr֯ c§c Ľ֗nh dӴng video sau: avi, mpe, mpeg, mpe, mp4, 

m4v, wma/asf, mov, qt, 3gp2, 3gpp, 3gp, 3g2, flv v¨ kԜ cӶ Ľ֗nh dӴng m֧i lӴ drv-ms nֻa. ChҼҺng tr³nh c· 

dung lҼ֯ng 5,17 MB, tӶi vԚ d½ng tӴi 

http://www.dvdvideosoft.com/download/FreeVideoToJPGConverter.exe. 

 

- Tַ giao di֓n ch²nh cֳa chҼҺng tr³nh, bӴn bӸm n¼t ba chӸm trong khung Input file v¨ chuyԜn sang thҼ 

mֱc chֵa c§c file video. K²ch ch֙n file video bӴn cӺn t§ch Ӷnh v¨ bӸm Open ĽԜ ch֙n. BӸm n¼t Play ĽԜ 

chҼҺng tr³nh bԂt ĽӺu ph§t file video. NԒu bӴn mu֝n t§ch h³nh Ӷnh tַ m֥t ĽoӴn file video bӸt kȢ th³ k®o 

thanh trҼ֯t t֧i v֗ tr² ĽӺu v¨ bӸm n¼t Trim Left sau Ľ· tiԒp tֱc k®o thanh trҼ֯t t֧i v֗ tr² kԒt th¼c v¨ bӸm n¼t 

Trim Right 

 

- Sau khi ch֙n ĽoӴn video xong, bӴn bӸm n¼t ba chӸm trong khung Output folder ĽԜ ch֙n thҼ mֱc chֵa 

c§c file Ӷnh sau khi chҼҺng tr³nh t§ch h³nh. 

 

- KԒ ĽԒn, bӴn ch֙n m֥t trong c§c kiԜu t§ch h³nh trong khung Save g֟m: 

 

Every ... frames: T§ch theo tַng s֝ lҼ֯ng khung h³nh bӴn mu֝n, tֵc l¨ cֵ sau bao nhiêu khung hình xác 

Ľ֗nh, chҼҺng tr³nh sԐ tֽ Ľ֥ng lҼu lӴi m֥t khung h³nh th¨nh file Ӷnh. 

 

Every ... seconds: T§ch h³nh theo th֩i gian thֽc, tֵc l¨ cֵ theo th֩i gian bӴn ch֙n chҼҺng tr³nh sԐ tֽ 

Ľ֥ng lҼu khung h³nh ֫ th֩i ĽiԜm Ľ· cho bӴn. 

 

Every frame: LҼu lӴi m֙i khung h³nh trong ĽoӴn video bӴn ch֙n. 

 

- Sau khi bӴn ch֙n kiԜu t§ch h³nh xong, bӴn bӸm n¼t Save ĽԜ chҼҺng tr³nh lҼu lӴi h³nh Ӷnh. Khi chҼҺng 

tr³nh l¨m vi֓c xong, bӴn bӸm n¼t Output folder... ĽԜ truy cԀp t֧i thҼ mֱc chֵa file Ӷnh m¨ chҼҺng tr³nh 

vַa lҼu xong. 

 

Ngo¨i ra trong khung xem file video, nԒu bӴn th²ch cӶnh n¨o bӴn c· thԜ bӸm n¼t Make Snapshot ĽԜ lҼu lӴi 

h³nh Ӷnh Ľ· lu¹n. TӸt cӶ c§c file Ӷnh ĽҼ֯c lҼu lӴi dҼ֧i dӴng jpeg, c· t°n tr½ng t°n v֧i file video g֝c v¨ 

th°m s֝ khung h³nh tӴi v֗ tr² t§ch Ӷnh ĽԜ ph©n bi֓t. 

 

http://www.dvdvideosoft.com/download/FreeVideoToJPGConverter.exe


(Theo TRͬN VŀN HUΛ - banmai_pc@yahoo.com | KHPT ) 

KhԂc phֱc m֥t s֝ trֱc trԊc cֳa c§c thiԒt b֗ USB 
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C¹ng cֱ USB kh¹ng l¨m vi֓c gi֝ng nhau ֫ c§c m§y t²nh kh§c nhau (l¼c nhԀn l¼c 

không): 
 

- Click n¼t chu֥t phӶi v¨o My Computer, Ch֙n Manage > Disk Management. KiԜm tra lӴi, coi c· t°n ֡ 

Ľǫa n¨o d¨nh cho c¹ng cֱ USB chҼa? NԒu chҼa c·, click tiԒp n¼t phӶi, ch֙n Change. KԒ Ľ·, bӴn thֹ coi 

c· ch֙n ĽҼ֯c t°n ֡ Ľǫa n¨o cho n· kh¹ng? 

 

- NԒu n· Ľ« c· t°n trong Disk Management, bӴn c· thԜ click n¼t phӶi ֫ Ľ· lӺn nֻa ĽԜ ch֙n Explorer. 

Explorer sԐ ĽҼ֯c g֙i v¨ bӴn thӸy c¹ng cֱ USB c½ng v֧i nhֻng g³ chֵa b°n trong. 

 

- CȈng lӴi click n¼t phӶi v¨o My Computer, ch֙n Properties r֟i Hardware > Device Manager. Bung tiԒp 

phӺn USB Controller, click n¼t phӶi r֟i ch֙n Uninstall tӸt cӶ danh s§ch c§c c¹ng cֱ USB. Reboot m§y 

t²nh lӴi. 

 

- N֝i trֽc tiԒp c¹ng cֱ USB ngay v¨o c֡ng USB thay v³ qua USB hub, coi c· kh§c nhau g³ kh¹ng? G֭ b֛ 

d©y n֝i c¹ng cֱ USB v¨ n֝i thԆng v¨o c֡ng USB hoԊc l¨ thay bԄng d©y khác. 

 

- NԒu c¹ng cֱ USB kh¹ng c· m¨ ch֕ c· ngu֟n Ľi֓n h֣ tr֯, thֹ n֝i v¨o h֓ th֝ng trҼ֧c v¨ sau khi boot. 

 

- NԒu vӸn ĽԚ lӴi l¨ c¹ng cֱ USB b°n ngo¨i, h«y thֹ d½ng ti֓n ²ch n¨o Ľ· k¯m theo USB (nԒu c·) ĽԜ coi n· 

hoӴt Ľ֥ng b³nh thҼ֩ng kh¹ng? 

 

- NԒu vӸn ĽԚ l¨ USB qua card PCI, h«y thay Ľ֡i qua m֥t khe cԂm PCI kh§c xem sao. 

 

- H«y gԂng cԀp nhԀt USB qua website cֳa ch²nh h«ng Ľ·, cȈng nhҼ kiԜm tra th°m nhֻng giӶi ph§p ĽԚ 

ngh֗ cֳa h֙. NhiԚu khi bӴn cԀp nhԀt BIOS, driver chipset cho mainboard ch²nh h«ng lӴi giӶi quyԒt ĽҼ֯c 

vӸn ĽԚ. 

 

Icon Safely Remove hardware Ľ֥t nhi°n biԒn mӸt: 

 

Thֹ khԂc phֱc bԄng m֥t trong c§c c§ch sau: 
 

1. L¨m xuӸt hi֓n lӴi icon: NԒu bӴn Ľ« giӸu c§c icon kh¹ng d½ng tr°n khay h֓ th֝ng, n°n kh¹i phֱc 

ch¼ng lӴi bԄng c§ch click n¼t phӶi v¨o v½ng cӴnh b°n c§i Ľ֟ng h֟, ch֙n Properties, b֛ Ľi n¼t kiԜm Hide 

inactive icons, click tiԒp OK, sԐ hi֓n lӴi ĽҼ֯c c§c icon Ľ« ĽҼ֯c giӸu Ľi . 



 

2. Kh֫i Ľ֥ng lӴi cֹa s֡ Safely remove hardware: 
 

- V¨o Start > Run Ľ§nh d¸ng l֓nh sau: RUNDLL32 SHELL32.DLL, Control_RunDLL hotplug.dll r֟i 

Enter. Click v¨o ĽԚ mֱc ֫ phӺn th©n cֹa s֡ ĽԜ xem c§c thiԒt b֗¬ USB Ľ« c¨i. 

 

- Ch֙n Stop v¨o thiԒt b֗ n¨o m¨ bӴn cӺn r¼t ra. Sau Ľ· c· thԜ g֭ b֛ thiԒt b֗ USB an to¨n ĽҼ֯c r֟i. 

 

3. Reboot m§y lӴi cȈng Ľ¹i l¼c phֱc h֟i lӴi icon Safely remove hardware 
 

4. Vào Start > Control Panel, ch֙n Taskbar v¨ Start menu. TiԒp, ch֙n tab Customize. X֡ xu֝ng danh 

s§ch ĽԜ t³m ra Safely remove hardware. 

 

5. NԒu n· Ľ« b֗ Always hide, cֵ click Ľ¹i v¨o ĽӸy ĽԜ ch֙n lӴi l¨ Always show. Click v¨o OK r֟i tho§t 

ra. 

 

Khi click v¨o icon Safely remove hardware, c¹ng cֱ USB vӾn kh¹ng lӸy ra ĽҼ֯c: 

 

ņ©y l¨ sֽ kh¹ng Ľ֟ng b֥ trong vi֓c giӶi ph·ng b֥ nh֧, khi h֓ th֝ng Ľ֗nh g֭ b֛ USB. Microsoft Ľ« c· 

m֥t hotfix tӴi link n¨y: http://support.microsoft.com/kb/931619/en-us 

 

Khi gԂn c¹ng cֱ USB t¹i nghe tiԒng ding nhҼng r֟i lӴi kh¹ng c· g³ xӶy ra sau Ľ·. C¹ng cֱ USB kh¹ng 

thԜ nhԀn ra. NԒu t¹i ĽԜ y°n nhҼ vԀy, reboot m§y lӴi th³ lӴi nhԀn ra... 

 

Thֹ l¨m 1 trong 2 c§ch sau: 
 

1. V¨o menu Start, trong Search, g» Device Manager. Trong Device Manager, t³m ĽԒn USB Controllers. 

Click n¼t phӶi v¨o ĽӸy, ch֙n Properties v¨ ch֙n Write Caching Enable. 

 

2. V¨o Device Manager nhҼ hҼ֧ng dӾn ֫ tr°n, t³m ra USB Controllers. Click n¼t phӶi ch֙n Delete all 

USB controllers. Reboot m§y lӴi. XP hay Vista tֽ Ľ֥ng cԀp nhԀt lӴi hardware m֧i ch֕nh ĽҼ֯c loӴi hҼ 

h֛ng n¨y. 

 

(Theo D̮̬NG MINH HOêNG - drhoang@gmail.com | KHPT ) 

ThiԒt kԒ trang web dӴng flash chuy°n nghi֓p 

19.09.2010 21:27 

 

http://support.microsoft.com/kb/931619/en-us


Flash Website Design (FWD) l¨ phӺn mԚm gi¼p bӴn tӴo cho m³nh m֥t trang web mang ĽԀm phong c§ch 

flash. V֧i FWD bӴn c· thԜ tֽ thiԒt kԒ m֥t banner, logo, hoԊc nguy°n cӶ m֥t website dӴng flash rӸt nhanh 

ch·ng v¨ chuy°n nghi֓p. 

 

ņӺu ti°n bӴn h«y tӶi Flash Website Design Pro bӶn  d½ng thֹ tӴi Ľ֗a ch֕ 

http://www.flasheffect.net/flashwebsitedesign.zip hoԊc http://tinyurl.com/2dfro4. BӶn full cֳa phӺn mԚm 

n¨y c· thԜ tӶi tӴi http://vietsoft.demo.to. 

 

Giao di֓n cֳa FWD rӸt trֽc quan, phӺn tr°n g֟m c§c thԎ ĽҼ֯c ph©n theo thԜ loӴi: 

 

- ņΘ thiΔt kΔ logo, banner: Html Website, Banner, Back Ground, Line, People, Nature... 

- ņΘ thiΔt kΔ cͩ trang web b΄ng flash: Intro-1, Intro-2, Website. 

 

PhӺn n¨y cung cӸp rӸt nhiԚu mӾu ĽԜ c§c bӴn thiԒt kԒ. PhӺn dҼ֧i g֟m c§c thԎ Flash Editor v¨ thԎ HTML 

Editor. 

 

ǒ Flash Editor 
 

Bao g֟m c§c mֱc ĽԜ bӴn ch֕nh sֹa nhֻng mӾu Ľ« tӴo ֫ tr°n, Ľ§ng ch¼ Ĩ l¨ mֱc: 

 

- Swf Option: NhԀp th¹ng s֝ cho file flash m¨ bӴn tӴo ra, nhҼ chiԚu cao, chiԚu r֥ng, hiԜn th֗ nhanh hoԊc 

chԀm, n®n (Compressed) hay kh¹ng n®n file... 
 

- Back Ground: Ch֙n Transparent ĽԜ hiԜn th֗ chԒ Ľ֥ trong su֝t cho file flash, ch֙n SolidColor l¨ m¨u nԚn 

cֳa file (mԊc Ľ֗nh l¨ nԚn trԂng), ch֙n Image Fill ĽԜ ch¯n Ӷnh nԚn... 

 

- Mouse AS: Ch֕nh hi֓u ֵng khi r° chu֥t v¨o nԚn flash. 

 

- Percent Loader: Hi֓u ֵng Loading rӸt ĽԌp mԂt ĽԜ tӶi flash Ľ·, hi֓u ֵng n¨y l¨m cho file flash cֳa bӴn 

tr֫ n°n sinh Ľ֥ng hҺn, mang t²nh chuy°n nghi֓p cao. 

 

- Sound: Ąm thanh cֳa file Ľ· khi hiԜn th֗, bӴn c· thԜ lֽa ch֙n bԄng file nhӴc cֳa m³nh (mp3,wav), hoԊc 

sֹ dֱng file nhӴc Ľ« c· sԈn cֳa Flash Website Design. 

 

- Trong thԎ Flash Editor, bӴn c¸n c· thԜ th°m c§c button (n¼t Ӹn) rӸt ĽԌp, rӸt nhiԚu mӾu. BӴn h«y ĽiԚn t°n 

v¨o khung Caption, tӴi mֱc Create Local Web bӴn ĽiԚn url ĽԜ li°n kԒt t֧i trang m¨ bӴn Ӹn v¨o n¼t Flash. 

 

ǒ HTML Editor  
 

Bao g֟m c§c mֱc ĽԜ bӴn thiԒt lԀp trang Index mԊc Ľ֗nh v֧i nhiԚu mӾu v¨ kԒt h֯p v֧i file flash m¨ bӴn Ľ« 

tӴo ֫ tr°n. BӴn c· thԜ d½ng Front Pages ĽԜ thiԒt kԒ lӴi theo Ĩ m³nh. Trong ¹ Preview, khi r° chu֥t qua bӴn 

sԐ thӸy c· nhiԚu khung Ľ֛ hi֓n l°n, bӴn c· thԜ nhӸn v¨o Edit b°n cӴnh ĽԜ ch֕nh sֹa lӴi th©t Ҽng Ĩ. 

 

Saves file flash vào máy 
 

- Vi֓c cu֝i c½ng l¨ bӴn lҼu v¨o m§y, bӴn ch֙n File > Save HTML/ FLASH. Flash Website Design sԐ cho 

bӴn thֹ bԄng m֥t trang demo, bӴn c· thԜ m֫ bԄng Front Page ĽԜ sֹa lӴi. 

 

- ChuyԜn sang dӴng gif ĽԜ l¨m logo quӶng c§o: bӴn c· thԜ sֹ dֱng phӺn mԚm Magic Swf2Gif ĽԜ chuyԜn 

swf th¨nh Ӷnh gif, tӶi phӺn mԚm tӴi http://vietsoft.demo.to. 

 

LҼu Ĩ 

 

BӴn n°n ch֙n m֥t hosting t֝t, nhanh ĽԜ c· thԜ hoӴt Ľ֥ng khi ch¯n file n¨y, kh¹ng n°n trình bày trang 

index cֳa bӴn qu§ Ľ֟ s֥ sԐ dӾn t֧i t³nh trӴng tӶi web rӸt chԀm. 

 



(Theo NGUYΙN VIΛT ANH - vietsoft.demo.to@gmail.com | KHPT ) 

NhiԚu thֳ thuԀt audio/video d֑ l¨m v֧i Windows Movie Maker 

19.09.2010 18:51 

 

C· lԐ tַ trҼ֧c ĽԒn nay ch¼ng ta Ľ« qu§ ch¼ t©m ĽԒn c§c phӺn mԚm bi°n tԀp video h¨ng ng¨y quӶng c§o 

tr°n mӴng m¨ qu°n mӸt Ľi Windows Movie Maker (WMM), m֥t chҼҺng tr³nh sԈn c· trong h֓ ĽiԚu h¨nh 

Windows XP. M֥t s֝ thֳ thuԀt dҼ֧i Ľ©y, mԊc d½ c· t²nh thֳ c¹ng, nhҼng ch¼ng ĽҼ֯c thֽc hi֓n kh§ ĽҺn 

giӶn v¨ d֑ d¨ng v֧i WMM. 

 

Kh֫i Ľ֥ng Windows Movie Maker (WMM). ņԜ thao t§c v֧i c§c ĽoӴn phim v¨ music bӴn bӴn phӶi ĽҼa 

ch¼ng v¨o cֹa s֡ Collections bԄng c§ch bӸm t֡ h֯p ph²m Ctrl+I, ch֙n c§c tԀp tin cӺn thao t§c sau Ľ· bӸm 

Import. 

 

Chú ý: Khi Import file video, bӴn b֛ dӸu check ֫ mֱc Create clips for video file nԄm ph²a dҼ֧i h֥p thoӴi 

Import (Ľ©y l¨ t²nh nŁng tֽ Ľ֥ng chia ĽoӴn video th¨nh nhiԚu phӺn). 

 

Thay Ľ֡i phӺn nhӴc cֳa ĽoӴn phim 
 

- Tַ cֹa s֡ Collections, bӴn k®o ĽoӴn phim v¨ bӶn nhӴc thay thԒ, lӺn lҼ֯t ĽԊt v¨o khe Video v¨ khe 

Audio/Music cֳa khung Timeline. 

 

- L¼c n¨y tr°n khung Timeline xuӸt hi֓n 3 ĽҼ֩ng thԆng m¨u x§m. BӴn click chu֥t phӶi l°n ĽҼ֩ng m¨u 

x§m thֵ 2, ch֙n Mute ĽԜ v¹ hi֓u h·a phӺn nhӴc cȈ cֳa ĽoӴn phim. 

 

- BӸm t֡ h֯p ph²m Ctrl+P ĽԜ xuӸt bӶn t§c phӼm. T§ch phӺn nhӴc cֳa ĽoӴn phim 

 

- BӴn k®o ĽoӴn phim xu֝ng khe Audio/Music cֳa khung Timeline. L¼c n¨y tr°n khung Timeline ch֕ xuӸt 

hi֓n m֥t ĽҼ֩ng m¨u x§m, Ľ· ch²nh l¨ phӺn nhӴc cֳa ĽoӴn phim. 

 

- BӸm t֡ h֯p ph²m Ctrl+P ĽԜ lҼu th¨nh file th¨nh dӴng wma. 

 

Chia nh֛ b֥ phim 
 

NhiԚu l¼c ta cӺn chia nh֛ b֥  phim ĽԜ d֑ d¨ng tӶi l°n mӴng cho bӴn b¯ xem. 

 

- D½ng chu֥t ch֙n b֥ phim trong cֹa s֡ Collections, sau Ľ· bӸm n¼t Play ֫ cֹa s֡ tr³nh chiԒu b°n cӴnh. 

BӴn xӶ b֥ phim ĽԒn v֗ tr² ĽӺu ti°n mu֝n chia, sau Ľ· bӸm n¼t Pause r֟i bӸm t֡ h֯p ph²m Ctrl+L. TiԒp tֱc 

bӸm n¼t Play, xӶ b֥ phim ĽԒn v֗ tr² thֵ 2 mu֝n chia, bӸm n¼t Pause r֟i bӺm t֡ h֯p ph²m Ctrl+L. Cֵ nhҼ 

thԒ, bӴn mu֝n chia b֥ phim th¨nh bao nhi°u phӺn cȈng ĽҼ֯c. 



 

- C§c ĽoӴn phim sau khi chia ĽҼ֯c Ľ§nh s֝ thֵ tֽ k¯m theo t°n file g֝c nԄm trong cֹa s֡ Collections. B©y 

gi֩ bӴn xuӸt bӴn tַng ĽoӴn phim Ľ· bԄng c§ch k®o ĽoӴn phim thֵ nhӸt xu֝ng khe Video r֟i bӸm t֡ h֯p 

ph²m Ctrl+P ĽԜ xuӸt bӶn. XuӸt bӶn xong, bӴn ch֙n ĽҼ֩ng m¨u x§m trong khung Timeline, bӸm phím 

Delete. Sau Ľ· bӴn xuӸt bӶn hԒt c§c ĽoӴn phim tiԒp theo gi֝ng nhҼ ĽoӴn phim thֵ nhӸt. 

 

 

Ch¼ Ĩ: Trong qu§ tr³nh xem phim ֫ cֹa s֡ tr³nh chiԒu cֳa WMM, bӴn c· thԜ chֱp lӴi bֵc Ӷnh trong phim 

bԄng c§ch bӸm n¼t Take Picture . 

 

N֝i c§c ĽoӴn phim, nhӴc BӴn ch֕ vi֓c k®o c§c ĽoӴn phim (hay nhӴc) cӺn n֝i, sԂp xԒp ch¼ng v¨o khe 

Video (hay khe Audio/ Music), sau Ľ· bӸm t֡ h֯p ph²m Ctrl+P ĽԜ xuӸt bӶn. 

 

CԂt b֛ m֥t phӺn n¨o Ľ· cֳa ĽoӴn nhӴc, phim 

 

Sau Ľ©y l¨ thao t§c v֧i m֥t ĽoӴn phim (v֧i nhӴc th³ tҼҺng tֽ): 
 

- ņoӴn phim sau khi k®o xu֝ng khe Video, bӴn c· thԜ x§c Ľ֗nh v֗ tr² m³nh mu֝n cԂt bԄng c§ch dֽa v¨o 

thanh thҼ֧c Timeline v¨ cֹa s֡ tr³nh chiԒu ֫ tr°n. 

 

- ņԜ cԂt b֛ phӺn ĽӺu hay phӺn cu֝i, bӴn d½ng chu֥t thu ngԂn phӺn ĽӺu hay phӺn cu֝i cֳa m֥t trong hai 

ĽҼ֩ng màu xám trong khung Timeline. 

 

- Ćp dֱng c§ch tr°n kԒt h֯p v֧i c§ch n֝i c§c ĽoӴn phim, ta c· thԜ cԂt b֛ m֥t ĽoӴn bӸt kȢ trong phim. 

 

- ņԜ xuӸt bӶn, bӴn bӸm t֡ h֯p ph²m Ctrl+P. 

 

L¨m phֱ ĽԚ cho phim 
 

Tַ khung Collection bӴn d½ng chu֥t k®o b֥ phim xu֝ng ĽԊt xu֝ng khe Video cֳa bӶng Timeline nԄm 

ph²a dҼ֧i giao di֓n ch²nh cֳa chҼҺng tr³nh. 

 

L¨m phӺn gi֧i thi֓u 



 

- B̯αc 1: GiΧng nh̯ c§c bί phim tr°n truyΖn h³nh, Ľͭu ti°n ta sΒ ch¯n phͭn giαi thiΜu c§c diΚn vi°n trong 

phim ε phͭn mε Ľͭu bί phim: V¨o menu Tools > Tiles and Credits, chΣn Title at the beginning . 

 

- B̯αc 2: Mίt cσa sΫ mαi hiΜn ra cho bͧn nhͻp lγi giαi thiΜu, bͧn khoan nhͻp m¨ h«y k®o thanh cuίn 

b°n cͧnh xuΧng ph²a d̯αi, sau Ľ· chΣn Chage the title animation khung hiΜu οng hiΜn ra. Bͧn h«y chΣn 

hiΜu οng có tên là Credits: Scroll, Up Side-by-Side. TiΔp tλc k®o thanh cuίn xuΧng ph²a d̯αi chΣn 

Change the text font and color ĽΘ ĽΠnh dͧng kiΘu chυ v¨ m¨u nΖn t½y theo Ĩ cνa bͧn. 

 

- B̯αc 3: TiΔp theo chΣn Edit the title text. B©y giγ th³ h«y nhͻp phͭn giαi thiΜu. 

 

- B̯αc 4: chΣn Done, add the title to movie ĽΘ kΔt th¼c. 

 

Ch¯n l֩i thoӴi 
 

- C§c bӴn lԊp lӴi c§c bҼ֧c tҼҺng tֽ nhҼ tr°n, nhҼng ֫ bҼ֧c 1 ch֙n Title on the selected clip, bҼ֧c 2 th³ 

ch֙n hi֓u ֵng l¨ Subtitle, c¸n bҼ֧c 3 bӴn nhԀp l֩i thoӴi ĽӺu ti°n cho nh©n vԀt, xong bӴn ch֙n Done, add 

the title to movie. 

 

- B©y gi֩ dҼ֧i bӶng Timeline, tr°n khe Title Overlay c· ĽoӴn phim nh֛ chֵa l֩i thoӴi bӴn nhԀp l¼c n«y. 

֪ tr°n c· m֥t cֹa s֡ tr³nh chiԒu, bӴn thֹ bӸm n¼t Play ĽԜ xem thֹ. Trong qu§ tr³nh xem thֹ, bӴn x§c Ľ֗nh 

v֗ tr² cӺn ĽԊt ĽoӴn phim nh֛ n¨y th¹ng qua ĽҼ֩ng ch֕ m¨u xanh chӴy tr°n thanh thҼ֧c Timeline. BӴn c· 

thԜ d½ng chu֥t k®o d¨i hay thu ngԂn ĽoӴn phim nh֛ n¨y ĽԜ cho l֩i thoӴi t֟n lӴi l©u hay nhanh tr°n ĽoӴn 

phim. BӴn cֵ ch֕nh sֹa sao cho l֩i thoӴi Łn kh֧p v֧i hoӴt cӶnh trong phim. ņԒn Ľ©y bӴn Ľ« ch¯n ĽҼ֯c l֩i 

thoӴi ĽӺu ti°n. ņԜ ch¯n l֩i thoӴi tiԒp theo, bӴn d½ng chu֥t ch֙n ĽoӴn phim nh֛ l¼c n«y, nhӸn ph²m 

Ctrl+C, r֟i Ctrl+V. Sau Ľ· bӴn thay Ľ֡i n֥i dung cֳa ĽoӴn phim vַa m֧i sao ch®p bԄng c§ch nhӸp Ľ¼p 

chu֥t v¨o n·, cֹa s֡ Enter Text for Title hi֓n ra (d½ng chu֥t k®o r֥ng cֹa s֡ n¨y ĽԜ d֑ thao t§c). BӴn h«y 

x·a ĽoӴn text cȈ v¨ nhԀp l֩i thoӴi m֧i v¨o, xong ch֙n Done. Sau Ľ·, bӴn cȈng d½ng chu֥t ch֕nh sֹa ĽoӴn 

phim thֵ 2 n¨y nhҼ ĽoӴn phim l¼c n«y. Cֵ nhҼ thԒ bӴn ch¯n c§c l֩i thoӴi tiԒp theo. 

 

L¨m phӺn kԒt th¼c 
 

BӴn cֵ thao t§c nhҼ phӺn gi֧i thi֓u, nhҼng ֫ bҼ֧c 1 bӴn ch֙n Credits at the end. C§c bҼ֧c kh§c bӴn c· 

thԜ thiԒt lԀp c§c t½y ch֙n theo Ĩ th²ch cֳa ri°ng m³nh. 

 

XuӸt bӶn phim 
 

NhӸn ph²m Ctrl+P, h֥p thoӴi th¹ng b§o hi֓n ra, bӴn ch֙n My Computer ĽԜ lҼu t§c phӼm v¨o m§y t²nh 

hoԊc ch֙n Recordable CD ĽԜ ghi trֽc tiԒp l°n Ľǫa CD. C§c bҼ֧c tiԒp theo bӴn l¨m theo hҼ֧ng dӾn tr°n 

màn hình. 

 

(Theo NGUYΙN VŀN PHĐC - phuclx@gmail.com | KHPT ) 

ChuyԜn nhanh t¨i li֓u vŁn bӶn sang dӴng thuyԒt tr³nh 

19.09.2010 18:49 



 

SԂp ĽԒn l¼c bӴn phӶi thuyԒt tr³nh r֟i, vԀy m¨ hi֓n tӴi trong tay bӴn vӾn chҼa c· tԀp tin thuyԒt tr³nh, ch֕ c· 

m֥t tԀp tin vŁn bӶn Ľ« soӴn. nhҼ vԀy l¨m sao c· thԜ sֹ dֱng phҼҺng ti֓n tr³nh chiԒu ĽԜ chiԒu l°n màn 

h³nh tַng n֥i dung cӺn minh h֙a? nԒu bӴn cֵ tiԒn h¨nh theo c§ch th¹ng thҼ֩ng (tֵc l¨ m֫ power point 

l°n r֟i soӴn tַng Ĩ dֽa theo vŁn bӶn word) th³ rӸt mӸt th֩i gian, cho d½ bӴn c· d½ng c§ch copy/paste. thֳ 

thuԀt nh֛ sau Ľ©y sԐ gi¼p bӴn chuyԜn tַ dӴng vŁn bӶn sang dӴng thuyԒt tr³nh m֥t c§ch nhanh ch·ng m¨ 

vӾn bӶo ĽӶm chuӼn, ĽԌp v¨ Ľ¼ng Ĩ. 

 

ņӺu ti°n bӴn m֫ Power Point l°n, v¨o menu File > Open. Trong mֱc File of type,   bӴn ch֙n All Files r֟i 

m֫ file Word Ľ« soӴn sԈn. Sau khi m֫ ra, c§c Ĩ trong bӶn thuyԒt tr³nh rӸt l֥n x֥n, m֣i gӴch ĽӺu d¸ng ĽԚu 

ĽҼ֯c ĽҼa v¨o m֥t slide. 

 



 

C¹ng vi֓c tiԒp theo cֳa bӴn l¨ ĽҼa ch¼ng v¨o Ľ¼ng ch֣. BӴn v¨o menu View > Normal, ch֙n kiԜu hiԜn 

th֗ Outline. V֧i m֣i Ĩ thu֥c Ĩ nh֛ trong Ĩ l֧n, bӴn b¹i Ľen c§c Ĩ nh֛ r֟i nhӸn Tab, c§c Ĩ nh֛ sԐ ĽҼ֯c ĽҼa 

v¨o c½ng slide v֧i Ĩ l֧n ֫ tr°n. V֧i c§c Ĩ nh֛ hҺn, bӴn nhӸn tiԒp ph²m Tab ĽԜ ch¼ng vԚ Ľ¼ng v֗ tr². Tuy 

nhi°n k²ch thҼ֧c chֻ vӾn chҼa ĽҼ֯c kh֧p v֧i slide (nhiԚu chֻ chӴy ra ngo¨i slide). BӴn qua khung soӴn 

thӶo, t³m n¼t AutoFit Options, bӴn nhӸn v¨o Ľ· v¨ ch֙n AutoFit Text to Place Holder. L¼c n¨y c§c chֻ sԐ 

tֽ Ľ֥ng ch֕nh k²ch c֭ cho ph½ h֯p v֧i slide. Trong trҼ֩ng h֯p chֻ qu§ nh֛ (do c· qu§ nhiԚu chֻ trong 

m֥t slide), bӴn n°n ĽҼa m֥t s֝ Ĩ sang slide sau. 

 

BӴn l¨m tҼҺng tֽ nhҼ vԀy cho c§c slide c¸n lӴi. Ri°ng c§c Ӷnh minh h֙a trong  vŁn bӶn, Power Point sԐ 

kh¹ng tֽ Ľ֥ng ĽҼa v¨o. BӴn copy c§c Ӷnh n¨y b°n file Word r֟i d§n v¨o c§c v֗ tr² ph½ h֯p trong bӶn 

thuyԒt tr³nh. 

 

C¹ng vi֓c tiԒp theo cֳa bӴn l¨ Ľ֙c lҼ֧t lӴi c§c slide ĽԜ b֛ b֧t c§c Ĩ thַa v¨ sֹa lӴi c§c l֣i ch²nh tӶ, c©u 

vŁn. BӴn v¨o menu Format > Fonts ĽԜ Ľ֗nh dӴng lӴi font chֻ trong c§c slide; Format > Bullets and 

Numbering ĽԜ Ľ֗nh dӴng lӴi kiԜu gӴch ĽӺu d¸ng v¨ Ľ§nh s֝ thֵ tֽ c§c ĽoӴn; Format > Alignment ĽԜ canh 

lԚ cho chֻ; Slide Show > Custom Animation ĽԜ th°m c§c hi֓u ֵng cho chֻ; Slide Show> Slide 

Transistion ĽԜ th°m hi֓u ֵng chuyԜn cӶnh giֻa c§c slide. 

 

BӴn v¨o tiԒp menu Format > Slide Design ĽԜ ch֙n khu¹n mӾu ph½ h֯p v֧i n֥i dung thuyԒt tr³nh. Cu֝i 

c½ng bӴn kiԜm tra lӴi to¨n b֥ r֟i lҼu v¨o Ľǫa ĽԜ chuӼn b֗ thuyԒt tr³nh. 

 

Ghi chú: 
 

- NԒu vŁn bӶn c· c§c Ĩ ĽҼ֯c b֝ tr² sԈn theo kiԜu gӴch ĽӺu d¸ng th³ vi֓c chuyԜn qua dӴng thuyԒt tr³nh rӸt 

nhanh. Trong c§c trҼ֩ng h֯p kh§c th³ bӴn phӶi ch֕nh lӴi Ĩ cho ph½ h֯p. 

 

- BӴn n°n sֹ dֱng th¨nh thӴo chԒ Ľ֥ soӴn thӶo Outline cֳa Power Point. Vi֓c n¨y sԐ gi¼p bӴn soӴn c§c 

silde nhanh hҺn v¨ b֝ tr² c§c Ĩ khoa h֙c hҺn. 

 

- So v֧i c§ch Ľ֙c tַng Ĩ r֟i copy/paste th³ c§ch n·i tr°n sԐ gi¼p bӴn tiԒt ki֓m rӸt nhiԚu th֩i gian m¨ vӾn 

bӶo ĽӶm Ľ¼ng khu¹n dӴng, c§ch trình bày. 

 

(Theo Tͦ XUĄN TR̮βNG - truongtx8@gmail.com | KHPT ) 

Thu ©m v¨ lҼu file video v¨o m§y t²nh 

19.09.2010 18:43 

 



BӴn Ľang c¸n s֫ hֻu nhiԚu bŁng tַ hoԊc Ľǫa nhֽa cȈ hay nhֻng cu֥n bŁng video v֧i ca kh¼c bӸt hֳ 

nhҼng m֣i lӺn mu֝n nghe, xem ch¼ng th³ lӴi phӶi d½ng ĽԒn m§y cassette, ĽӺu video nԊng nԚ m¨ ©m thanh 

th³ chԆng hay? BӴn bӸt ch֯t ph§t hi֓n ra m֥t chҼҺng tr³nh tr°n radio hay tivi kh§ hay v¨ mu֝n thu ch¼ng 

ĽԜ nghe lӴi nhҼng Ľang b֝i r֝i kh¹ng biԒt phӶi l¨m thԒ n¨o? VԀy tӴi sao bӴn kh¹ng nh֩ ĽԒn chiԒc m§y 

tính? 

 

C§c thiԒt b֗ kԒt n֝i 

 

ņԜ ĽҼa ©m thanh tַ m֥t thiԒt b֗ ph§t ©m v¨o m§y t²nh, bӴn cӺn m֥t d©y n֝i tַ thiԒt b֗ Ľ· ĽԒn m§y t²nh. 

PhӺn l֧n c§c thiԒt b֗ ĽԚu d½ng ng» cԂm 3 ly (3 mm) ĽԜ l¨m ng» xuӸt hoԊc nhԀn t²n hi֓u ©m thanh n°n bӴn 

ch֕ cӺn mua m֥t s֯i d©y c· 2 ĽӺu cԂm 3 ly l¨ ĽҼ֯c. N°n mua loӴi c· chiԚu d¨i 2 m hoԊc 3 m ĽԜ kh¹ng b֗ 

lӸn cӸn c§c thiԒt b֗ khi thֽc hi֓n. B°n cӴnh Ľ·, m֥t s֝ thiԒt b֗ kh¹ng d½ng ng» cԂm 3 ly ĽԜ xuӸt t²n hi֓u 

©m thanh m¨ d½ng 1 ng» cԂm tr¸n nh¹ ra ngo¨i, nԒu gԊp trҼ֩ng h֯p n¨y, bӴn mua s֯i d©y c§p c· 2 ĽӺu 

cԂm: m֥t ĽӺu l¨ loӴi 3 ly v¨ m֥t ĽӺu l¨ jack cԂm b¹ng sen. M֥t s֝ thiԒt b֗ c· ©m thanh Hi-fi th³ lӴi c· ĽԒn 

2 ĽӺu cԂm tr¸n ĽԜ xuӸt ©m, do vԀy bӴn phӶi mua s֯i d©y c· 3 ĽӺu cԂm: 2 ĽӺu jack cԂm b¹ng sen v¨ 1 ĽӺu 

3 ly. 

 

ņԜ ĽҼa h³nh Ӷnh v¨o m§y t²nh th³ c§p n֝i m֧i ch֕ l¨ ĽiԚu ki֓n cӺn, c¸n l¨m sao ĽԜ c֡ng nhԀn t²n hi֓u 

video m֧i l¨ ĽiԚu ki֓n Ľֳ. TrҼ֧c ti°n, bӴn kiԜm tra xem tr°n card m¨n h³nh cֳa m³nh c· c֡ng Video in 

hay chҼa; nԒu kh¹ng c· v¨ Ľang c· nhu cӺu xֹ lĨ phim Ӷnh hoԊc chҺi game, Ľ֟ng th֩i tr°n mainboard c· 

khe cԂm card m¨n h³nh th³ bӴn kiԜm tra khe cԂm card m¨n h³nh ĽԜ cӺn mua loӴi card m¨n h³nh AGP hoԊc 

PCI Express. C¸n nԒu kh¹ng c· nhu cӺu n¨y, bӴn c· thԜ mua card tivi c· ng» cԂm video in ĽԜ cԂm v¨o 
khe cԂm PCI hoԊc c֡ng USB, hoԊc chuy°n nghi֓p hҺn l¨ ñtԀuò thiԒt b֗ bԂt h³nh (capture) ĽԜ cԂm v¨o 

c֡ng USB cֳa m§y t²nh, gi¼p m§y t²nh nhԀn c§c t²n hi֓u video, audio tַ c§c thiԒt b֗ ph§t. LoӴi n¨y th³ gi§ 

cֳa n· hҺi ĽԂt nhҼng b½ lӴi cho chӸt lҼ֯ng h³nh Ӷnh cao hҺn nhֻng loӴi kh§c. Cu֝i c½ng, bӴn mua s֯i c§p 

n֝i c· 2 hoԊc 4 ĽӺu cԂm l¨ jack b¹ng sen hoԊc ĽӺu cԂm 3 ly, hoԊc vַa ĽӺu cԂm jack b¹ng sen v¨ vַa ĽӺu 

3 ly ĽԜ kԒt n֝i c§c thiԒt b֗ lӴi v֧i nhau. 

 

Ngo¨i ra, m֥t s֝ thiԒt b֗ ph§t h³nh c¸n c· ng» cԂm anten out ĽԜ xuӸt ©m thanh v¨ h³nh Ӷnh. Khi Ľ·, bӴn 

cӺn trang b֗ s֯i d©y n֝i anten RF. M֥t s֝ kh§c c¸n d½ng dӴng c֡ng S-Video ĽԜ ph§t hoԊc nhԀn t²n hi֓u 

h³nh v¨ tiԒng, tӸt nhi°n l¨ bӴn cȈng phӶi chuӼn b֗ c§p n֝i tҼҺng ֵng v֧i dӴng c֡ng cֳa c§c thiԒt b֗ cӺn kԒt 

n֝i. Khi Ľ·, thiԒt b֗ lԂp v¨o m§y t²nh cֳa bӴn cȈng phӶi c· ng» cԂm RF in (anten in) hoԊc S-Video in thì 

m֧i nhԀn ĽҼ֯c c§c t²n hi֓u truyԚn theo dӴng c§p n¨y. 

 

֪ cӶ vi֓c thu ©m v¨ ghi h³nh, ngo¨i c§c thiԒt b֗ kԒt n֝i v¨ d©y c§p, bӴn cӺn c¨i v¨o m§y t²nh m֥t phӺn 

mԚm c· chֵc nŁng thu ©m hoԊc bԂt h³nh ĽԜ lҼu ©m thanh, h³nh Ӷnh truyԚn v¨o m§y t²nh th¨nh file ©m 

thanh, video m֫ ĽҼ֯c tr°n m§y t²nh. 

 

KԒt n֝i c§c thiԒt b֗ lӴi v֧i nhau 

 

M֥t khi Ľ« trang b֗ ĽӺy Ľֳ c§c thiԒt b֗ kԒt n֝i, d©y c§p v¨ c¨i phӺn mԚm cӺn d½ng v¨o m§y t²nh. BӴn d½ng 

loӴi c§p tҼҺng ֵng cԂm v¨o ng» audio out (ng» cԂm headphone cȈng l¨ ng» audio out), video out cֳa thiԒt 

b֗ ph§t h³nh v¨ ĽӺu c¸n lӴi cֳa s֯i d©y cԂm v¨o ng» line in, video in cֳa thiԒt b֗ tr°n m§y t²nh. ChӴy 

chҼҺng tr³nh phӺn mԚm cӺn d½ng, m֫ thiԒt b֗ ph§t tiԒng, h³nh v¨ k²ch hoӴt c§c chֵc nŁng trong chҼҺng 

tr³nh phӺn mԚm ĽԜ n· nhԀn t²n hi֓u tַ m§y ph§t. Sau Ľ·, tiԒp tֱc ĽiԚu ch֕nh c§c th¹ng s֝ vԚ m¨u sԂc, §nh 

s§ng, tӺn s֝ ĽԜ ĽҼ֯c h³nh Ӷnh sԂc n®t v¨ ©m thanh hay v¨ l֧n. Cu֝i c½ng bӸm n¼t Rec hoԊc Capture ĽԜ bԂt 

ĽӺu thu ©m thanh, h³nh Ӷnh v¨o m§y t²nh. 

 

T½y v¨o c§c th¹ng s֝ ĽiԚu ch֕nh tr°n chҼҺng tr³nh phӺn mԚm m¨ file thu ĽҼ֯c sԐ c· k²ch thҼ֧c l֧n hoԊc 

cֽc l֧n. Do vԀy, bӴn cӺn d֙n dԌp ĽԜ ĽҼ֯c m֥t ֡ Ľǫa tr֝ng c· dung lҼ֯ng l֧n cho vi֓c lҼu trֻ c§c file thu 

ĽҼ֯c. Sau Ľ·, bӴn c· thԜ d½ng tiԒp c§c chҼҺng tr³nh cԂt file ©m thanh hoԊc cԂt h³nh, bi°n tԀp file audio, 

video thu ĽҼ֯c, thԀm ch² l¨ tӴo hi֓u ֵng cho ch¼ng. Tuy nhi°n, ĽԜ l¨m ĽҼ֯c vi֓c n¨y, Ľ¸i h֛i m§y t²nh 

cֳa bӴn phӶi c· cӸu h³nh mӴnh (CPU t֝c Ľ֥ cao, card m¨n h³nh c· dung lҼ֯ng b֥ nh֧ l֧n, RAM v¨ Ľǫa 

cֵng c· dung lҼ֯ng l֧n...), nԒu kh¹ng Ľ§p ֵng ĽҼ֯c th³ m§y t²nh sԐ b֗ treo khi thֽc hi֓n. Kinh nghi֓m 

cho thӸy, khi thֽc hi֓n c§c c¹ng vi֓c n¨y, bӴn n°n Ľ֗nh dӴng Ľǫa cֵng ֫ chԒ Ľ֥ NTFS thay cho FAT32 ĽԜ 

h³nh Ӷnh thu ĽҼ֯c kh¹ng b֗ giֽt, Ľ֟ng th֩i t֝i Ҽu trong vi֓c lҼu trֻ.  



 

(Theo CAO KIΓN NAM | KHPT ) 

Hi֓n bӶn n֥i quy trҼ֧c khi ĽŁng nhԀp 

19.09.2010 18:40 

 

Mu֝n tӴo m֥t bӶn n֥i quy trҼ֧c khi h֥p thoӴi ĽŁng nhԀp mԀt khӼu Win XP xuӸt hi֓n ĽԜ nhԂc nh֫ ngҼ֩i 

d½ng thֽc hi֓n nghi°m ch֕nh c§c quy Ľ֗nh cֳa ph¸ng m§y, bӴn c· thԜ sֹ dֱng m֥t chֵc nŁng c· sԈn cֳa 

Win XP ĽԜ l¨m vi֓c n¨y: 

 

- Bͫm v¨o Start > Settings > Control Panel. 

- Bͫm Ľ¼p v¨o biΘu t̯ιng Administrative Tools. 

- Bͫm Ľ¼p tiΔp v¨o biΘu t̯ιng Local Security Policy. 

- Bͫm v¨o dͫu + tr̯αc mλc Local Policies. 

- Bͫm v¨o Security Options tr̭ng danh s§ch Ľ̯ιc xΫ ra ε d̯αi. 

- T³m d¸ng Interactive logon: Message title for users attempting to log on (trong khung b°n phͩi) v¨ bͫm 

Ľ¼p v¨o d¸ng n¨y. G» ti°u ĽΖ th¹ng b§o v¨o khung trong hίp thoͧi. D¸ng n¨y kh¹ng n°n g» dͫu tiΔng 

ViΜt v³ c§c dͫu sΒ kh¹ng hiΘn thΠ Ľ̯ιc. 

 

Th² dֱ: NOI QUY PHONG MAY TINH  

 

- N°n canh giυa d¸ng chυ ĽΘ khi hiΘn thΠ Ľ̯ιc c©n ĽΧi. 

- Xong bͫm OK. 

- T³m v¨ bͫm Ľ¼p v¨o d¸ng Interactive logon: Message text for users attempting to log on. G» nίi dung 

th¹ng b§o v¨o ¹ trΧng, c· thΘ g» tiΔng ViΜt c· dͫu. Ch̯̭ng tr³nh cho ph®p bͧn g» 19 d¸ng th¹ng b§o v¨o 

ô này. 

- G» xong bͫm OK. 

- Log off hoΊc khεi Ľίng lͧi m§y ĽΘ xem kΔt quͩ. 

 

NhҼ vԀy m֣i lӺn kh֫i Ľ֥ng m§y t²nh, bӶn n֥i quy ph¸ng m§y lӴi hiԜn th֗ nhԂc nh֫ ngҼ֩i nhֻng ĽiԚu cӺn 

làm. 

 

(Theo D̮̬NG MͦNH HĒNG - xuanthinhvtlt@yahoo.com | KHPT ) 

Phֱc h֟i ph©n v½ng b֗ mӸt sau khi ph©n v½ng lӴi kh¹ng th¨nh c¹ng 

19.09.2010 18:39 



 

ͨnh minh hΣa 

V aַ r֟i, t¹i d½ng hirentôboot g֥p m֥t phӺn dung lҼ֯ng ph©n v½ng c v¨o ph©n v½ng d th³ b֗ l֣i. khi d½ng 

paragon partition manager (trong Ľǫa boot) ĽԜ xem th³ thӸy c§c ph©n v½ng d, e, f b֗ tr֥n v¨o nhau th¨nh 

ph©n v½ng free! L¼c Ľ·, t¹i thֽc sֽ hoӶng h֝t, nhiԚu dֻ li֓u biԒn mӸt, v¨o win t³m cȈng kh¹ng thӸy Ľ©u. 

Tuy nhi°n sau Ľ· t¹i cȈng phֱc h֟i ĽҼ֯c c§c ph©n v½ng Ľ« mӸt, xin ghi ra kinh nghi֓m ĽԜ c§c bӴn tham 

khӶo. 

 

ņiԚu trҼ֧c ti°n l¨ Ľַng format phӺn Free, nԒu kh¹ng n· sԐ g֥p c§c ph©n v½ng lӴi th¨nh m֥t, l¼c Ľ· dֻ 

li֓u rӸt kh· cֵu. ņ©y ch֕ l¨ biԜu hi֓n cֳa vi֓c ph©n v½ng b֗ x·a m¨ th¹i. NԒu ta phֱc h֟i ĽҼ֯c c§c ph©n 

v½ng th³ sԐ thӸy lӴi dֻ li֓u y°u quĨ cֳa ta th¹i! ņԜ phֱc h֟i, bӴn tiԒn h¨nh theo c§c bҼ֧c qua 2 giai ĽoӴn 

nhҼ sau: 

 

1. Phֱc h֟i c§c ph©n v½ng (partition)  

 

- Cho Ľǫa boot v¨o ֡ CD (chԂc chԂn l¨ Ľ« cho First boot l¨ CDROM, nԒu kh¹ng v¨o BIOS ĽiԚu ch֕nh lӴi) 

v¨ kh֫i Ľ֥ng m§y. 

- Sau Ľ· ta ch֙n 2 (Start BbootCD) và Enter. 

- TiԒp t֧i ta ch֙n 1 (Disk Partition Tools...) và Enter. 

- TiԒp t֧i ta ch֙n 3 (Paragon Partition Manager) v¨ Enter. Giao di֓n cֳa Paragon Partition Manager sԐ 

hi֓n ra. 

- D½ng chu֥t ch֙n v¨o phӺn Free (l¨ phӺn ta cӺn cֵu), sau Ľ· bӸm chu֥t phӶi ch֙n UnDelete. 

- M֥t th¹ng b§o hi֓n ra, ĽӴi Ĩ ñbӴn c· mu֝n phֱc h֟i lӴi c§c partition Ľ« x·a kh¹ngò. BӴn ch֙n OK. 
- Sau Ľ·, cȈng sԐ c· th¹ng b§o nhҼng bӴn cֵ OK th¹i, Ľַng bӸm v¨o checkbox. 

- Sau Ľ· v¨i gi©y, chҼҺng tr³nh sԐ t³m lӴi ĽҼ֯c partition ĽӺu ti°n. BӴn ch֙n Cancel ĽԜ dַng tiԒn tr³nh lӴi, 

mֱc Ľ²ch l¨ phֱc h֟i tַng partition m֥t. 

- Còn 2 partition nֻa (trong trҼ֩ng h֯p n¨y), ta lӴi click chu֥t phӶi v¨o phӺn Free c¸n lӴi v¨ cȈng ch֙n 

Undelete r֟i bӸm OK v¨ OK. 

- L¼c n¨y sԐ hi֓n ra m֥t bӶng h֛i bӴn mu֝n phֱc h֟i partition n¨o trҼ֧c, bӴn ch֙n m֥t trong hai. HoԊc 

cֵ bӸm OK, n· sԐ phֱc h֟i partition E. PhӺn Free c¸n lӴi ta lӴi ch֙n UnDelete... V¨ nhҼ vԀy bӴn Ľ« phֱc 

h֟i lӴi ĽҼ֯c c§c ph©n v½ng ֡ Ľǫa cֳa m³nh r֟i. 

 

2. Phֱc h֟i dֻ li֓u 

 

Ri°ng ph©n v½ng m¨ trҼ֧c Ľ· bӴn Ľ« tiԒn h¨nh thao t§c g֥p v¨ b֗ b§o l֣i (cֱ thԜ trong trҼ֩ng h֯p n¨y l¨ 

phân vùng D), bӴn chҼa thԜ truy xuӸt dֻ li֓u ĽҼ֯c. NԒu click chu֥t phӶi v¨o ֡ D ch֙n Properties, bӴn sԐ 

thӸy n· c· dung lҼ֯ng 0 byte. V¨o DOS th³ bӴn nh³n thӸy ĽҼ֯c c§c thҼ mֱc nhҼng kh¹ng thԜ copy dֻ 

li֓u ĽҼ֯c. 

 

ņԜ c· thԜ truy xuӸt dֻ li֓u b³nh thҼ֩ng, bӴn cӺn phӶi d½ng m֥t chҼҺng tr³nh phֱc h֟i dֻ li֓u nhҼ 

RecoverMyFiles, DataRecovery... nhҼng theo t¹i, t֝t nhӸt l¨ d½ng GetDataBack bӶn portable (ĽԜ kh֛i 



phӶi c¨i). 

 

- Format lӴi ph©n v½ng D (n°n format theo h֓ NTFS ĽԜ phֱc h֟i dֻ li֓u nhanh hҺn v¨ file phֱc h֟i ²t b֗ 

l֣i): BӸm chu֥t phӶi v¨o ֡ D (tֵc l¨ ph©n v½ng kh¹ng m֫ ĽҼ֯c), ch֙n Format, trong File system ch֙n 

NTFS, sau Ľ· bӸm OK. Khi Ľ« format xong, bӴn c· thԜ m֫ ĽҼ֯c ֡ D nhҼng tӸt nhi°n l¨ kh¹ng nh³n thӸy 

g³ cӶ. Ta phӶi phֱc h֟i dֻ li֓u tӴi ֡ D bԄng GetDataBack 3.03 portable (c§c phi°n bӶn trҼ֧c 2.xx cho 

hi֓u quӶ kh¹ng cao, t֝c Ľ֥ chԀm). 

 

- ņӺu ti°n ch¼ng ta chӴy file PortableGetDataBackFATand NTFSv3.03. Giao di֓n chҼҺng tr³nh ĽҼa ra 

2 chֵc nŁng cֵu dֻ li֓u: GetDataBack FAT và GetDataBack NTFS. V³ ֡ D ĽҼ֯c format theo NTFS, ta 

ch֙n GetDataBack NTFS. 

 

- Giao di֓n l¨m vi֓c tiԒp theo c· 4 mֵc ĽԜ ch֙n t½y theo sֽ hiԜu biԒt cֳa ngҼ֩i d½ng: 1. MԊc Ľ֗nh (kh¹ng 

biԒt mӸt dֻ li֓u v³ l² do g³), 2. MӸt dֻ li֓u do format hay fdisk, 3. MӸt dֻ li֓u do c¨i m֧i h֓ ĽiԚu h¨nh, 4. 

Phcֱ h֟i c§c file b֗ x·a. Trong trҼ֩ng h֯p n¨y t¹i ch֙n mֵc 2, bӸm Next. 

 

- Giao di֓n l¨m vi֓c tiԒp theo xuӸt hi֓n. NԒu m§y c· nhiԚu ֡ Ľǫa cֵng th³ bӴn ch֙n ֡ Ľǫa cֵng c· chֵa 

ph©n v½ng m¨ mu֝n phֱc h֟i dֻ li֓u. 

 

- Click vào vùng Logical Drives. Danh sách các ph©n v½ng (D, E, C, F) hi֓n ra. Trong trҼ֩ng h֯p n¨y, 

t¹i ch֙n D, bӸm Next. 

 

- Qu§ tr³nh t³m kiԒm bԂt ĽӺu, bӴn cֵ ĽԜ cho n· chӴy khoӶng 3 ph¼t, giao di֓n Select File System sԐ hi֓n 

ra. BӸm Next. 

 

- TiԒp Ľ· t֧i giao di֓n Recovery Tree. ņ©y ch²nh l¨ cӸu tr¼c thҼ mֱc trong ph©n v½ng m¨ bӴn Ľ« mӸt dֻ 

li֓u. 

 

- Ch֙n thҼ mֱc cӺn phֱc h֟i (kh¹ng n°n ch֙n phֱc h֟i tַng file v³ sԐ rӸt kh· sԂp xԒp). Ch֙n Copy tr°n 

thanh c¹ng cu. Ch֙n ĽҼ֩ng dӾn (mԊc Ľ֗nh l¨ C:DOCUME~1ADMINI~1LOCALS~1Temp RarSFX0 ). 

Theo tôi không nên ch֙n mԊc Ľ֗nh, m¨ n°n ch֙n theo sֽ thuԀn ti֓n cֳa m³nh, lҼu Ĩ vԚ dung lҼ֯ng. V² dֱ 

thҼ mֱc bӴn mu֝n phֱc h֟i c· dung lҼ֯ng 4 GB m¨ ph©n v½ng bӴn ch֙n ĽԜ lҼu ch֕ tr֝ng 3 GB th³ kh¹ng 

ĽҼ֯c. BӴn phӶi t³m ph©n v½ng c· dunglҼ֯ng tr֝ng l֧n hҺn, hoԊc phӶi phֱc h֟i tַng thҼ mֱc con, l¼c n¨o 

ĽӺy ֡ th³ lҼu v¨o nҺi kh§c. Ch֙n ĽҼ֩ng dӾn xong, bӸm OK. 

 

- Qu§ tr³nh phֱc h֟i bԂt ĽӺu. Trong khi Ľang phֱc h֟i dֻ li֓u, bӴn kh¹ng n°n bӸm Stop. 

 

BӴn c· thԜ t³m link download GetDataBack  portable bԄng c§ch v¨o www.google.com.vn, g» tַ kh·a 

PortableGetDataBackFAT andNTFSv3.03 ĽԜ t³m, hoԊc li°n h֓ v֧i Ľ֗a ch֕ e-mail ghi dҼ֧i Ľ©y. 

 

(Theo NGĎ KIM THUͺN - ngokimthuan@gmail.com | KHPT ) 

Duy֓t c§c cֹa s֡ cֳa Windows Explorer theo dӴng tab 

17.09.2010 16:40 

http://www.google.com.vn/


 

Duy֓t web theo thԎ gi֩ Ľ« kh¹ng c¸n l¨ m֧i mԎ v֧i c§c tr³nh duy֓t nhҼ Firefox, Internet Explorer, Opera 

nhҼng duy֓t Windows Explorer theo dӴng thԎ th³ ²t ngҼ֩i biԒt t֧i. V֧i QTTabBar, bӴn sԐ sֹ dֱng ĽҼ֯c 

chֵc nŁng hֻu ²ch n¨y. 

Sau khi tӶi c¹ng cֱ n¨y tӴi Ľ֗a ch֕ http://tinyurl.com/3ymluej , bӴn v¨o thֽc ĽҺn View ï> toolbars r֟i 

Ľ§nh dӸu ch֙n QT TabBar Standard Buttons và QT TabBar nhҼ h³nh. 

  

 
  

Sau khi ch֙n, bӴn sԐ c· thԜ sֹ dֱng chֵc nŁng duy֓t cֹa s֡ theo thԎ. 

  

 

 

C§c t²nh nŁng ch²nh cֳa QTTabBar: 
 

T²nh nŁng thԎ (Tab)  
 

BӴn c· thԜ m֫ nhiԚu thԎ bԄng c§ch chu֥t phӶi v¨o thԎ hi֓n tӴi r֟i ch֙n Clone this. 

  

http://tinyurl.com/3ymluej


 
  

V֧i thao t§c tr°n, t¹i Ľ« m֫ c½ng l¼c nhiԚu cֹa s֡ Windows Explorer theo dӴng thԎ n°n bӴn sԐ tiԒt ki֓m 

ĽҼ֯c nhiԚu th֩i gian khi cӺn chuyԜn Ľ֡i qua lӴi giֻa c§c thҼ mֱc tr°n c§c ֡ Ľǫa kh§c nhau.  

 

Truy cԀp c§c thҼ mֱc d֑ d¨ng 
 

C¹ng cֱ n¨y cho ph®p bӴn d֑ d¨ng truy cԀp tӸt cӶ c§c thҼ mֱc m֥t c§ch nhanh ch·ng. BӴn c· thԜ xem tӸt 

cӶ c§c thҼ mֱc, thҼ mֱc con theo dӴng ñc©y thҼ mֱcò. 

  

 

 

M֫ lӴi thԎ l֭ tay Ľ·ng 
 

C¹ng cֱ cȈng ghi lӴi c§c thao t§c bӴn Ľ« l¨m Ľ֝i v֧i c§c thԎ n°n bӴn c· thԜ m֫ lӴi thԎ Ľ« l֭ tay Ľ·ng bԄng 

c§ch v¨o biԜu tҼ֯ng c§i Ľ֟ng h֟ r֟i x֡ danh s§ch c§c thԎ bӴn Ľ« tַng duy֓t v¨ ch֙n thԎ bӴn mu֝n kh¹i 

phֱc. 

  



 

Thêm vào danh sách yêu thích 
 

Lֽa ch֙n n¨y gi֝ng v֧i t²nh nŁng cֳa tr³nh duy֓t Internet Explorer n°n bӴn c· thԜ lҼu lӴi tӸt cӶ nhֻng thҼ 

mֱc bӴn hay truy cԀp. ņԜ sֹ dֱng chֵc nŁng n¨y, bӴn chu֥t phӶi ch֙n v¨o bӸt kȢ thԎ n¨o r֟i ch֙n Creat 

New Group v¨ ĽԊt t°n cho nh·m vַa tӴo. Sau Ľ· bӴn k®o thӶ c§c thԎ thҼ mֱc bӴn hay gh® thŁm thҼ֩ng 

xuy°n v¨ tַ gi֩ tr֫ Ľi bӴn ch֕ cӺn ch֙n t°n nh·m bӴn vַa tӴo l¨ c§c thҼ mֱc tr°n sԐ ĽҼ֯c m֫ ra cho bӴn 

m֥t c§ch Ľ֟ng th֩i. 

  

 

 

ņԜ them m֥t thҼ mֱc n¨o v¨o nh·m Ľ« tӴo, bӴn chu֥t phӶi v¨o thԎ cֳa thҼ mֱc Ľ· r֟i ch֙n Add to 

Group, trong b¨i t¹i c· nh·m t°n Daily v¨ t¹i th°m thҼ mֱc Win7 v¨o danh s§ch y°u th²ch. 

 

  

 

  

 

(Theo XHTT ) 

CCleaner - Mi֑n ph² v¨ th¹ng dֱng nhӸt trong vi֓c d֙n dԌp h֓ th֝ng 

16.09.2010 20:37 



 

Hi֓n nay c· kh§ nhiԚu ti֓n ²ch t֝i Ҽu h·a m§y t²nh nhҼ Tuneup Utilities, Your Uninstaller ... Tuy nhi°n, 

Ľa s֝ ĽԚu Ľ¸i h֛i bӶn quyԚn v֧i mֵc gi§ kh§ cao. NԒu hi֓n gi֩ m§y t²nh bӴn Ľang c· tri֓u chֵng ñr½a b¸ò 

hay ĽӴi loӴi nhҼ thԒ th³ bӴn n°n c¨i ĽԊt ngay c¹ng cֱ CCleaner ĽԜ thӸy ĽҼ֯c t§c dֱng tuy֓t v֩i cֳa ti֓n 

²ch mi֑n ph² n¨y nhҼ thԒ n¨o... 

 

CCleaner l¨ m֥t ti֓n ²ch cֳa h«ng Piriform d½ng ĽԜ t֝i Ҽu h·a h֓ th֝ng d¨nh cho Windows. Nhi֓m vֱ 

cֳa chҼҺng tr³nh l¨ qu®t Ľi to¨n b֥ nhֻng tԀp tin r§c, nhֻng tԀp tin kh¹ng cӺn thiԒt gi¼p Windows c· thԜ 

chӴy nhanh hҺn, giӶi ph·ng kh¹ng gian ֡ cֵng v¨ khԂc phֱc c§c l֣i registry m֥t c§ch nhanh ch·ng trong 

v¸ng chҼa ĽӺy m֥t gi©y. BӴn c· thԜ download v¨ c¨i ĽԊt phӺn mԚm n¨y tӴi Ľ֗a ch֕: 

http://www.ccleaner.com/download. 

 

Sau khi c¨i ĽԊt th¨nh c¹ng, bӴn c· thԜ nhԂp Ľ¹i shortcut Ccleaner tr°n desktop ĽԜ kh֫i Ľ֥ng chҼҺng tr³nh. 

Giao di֓n tҼҺng t§c ĽӺu ti°n cho thӸy, CCleaner c· 4 chֵc nŁng ch²nh tҼҺng ֵng v֧i 4 tab: Cleaner, 

Registry, Tools v¨ Options v¨ tab mԊc Ľ֗nh sau kh֫i Ľ֥ng l¨ Cleaner. 

 

ƴ Cleaner 

 

ChҼҺng tr³nh sԐ tֽ Ľ֥ng qu®t nhֻng file r§c cֳa h֓ th֝ng cȈng nhҼ c§c file tӴm trҼ֧c khi c¨i ĽԊt cֳa c§c 

phӺn mԚm. ņԜ x·a r§c cho Windows, bӴn ch֙n thԎ Windows v¨ nhԂp Analyze ĽԜ chҼҺng tr³nh ph©n t²ch 

h֓ th֝ng nhԄm khӶo s§t nhֻng file n¨o kh¹ng cӺn thiԒt v¨ cֱ thԜ ch¼ng nԄm ֫ Ľ©u. 

 

KԒt th¼c qu§ tr³nh, bӴn sԐ nhԀn ĽҼ֯c b§o c§o li֓t k° b°n cӴnh v¨ bӴn h«y nhԂp Run Cleaner > OK ĽԜ chӸp 
nhԀn chҼҺng tr³nh l¨m vi֓c v¨ x·a c§c file Ľ· Ľi. Thao t§c cȈng tҼҺng tֽ Ľ֝i v֧i thԎ Applications. V֧i 

chֵc nŁng n¨y, chҼҺng tr³nh sԐ x·a Ľi c§c file kh¹ng cӺn thiԒt cֳa c§c ֵng dֱng v¨ HņH: Internet 

Explorer (Temporary files, URL history, Cookies, Autocomplete form history, index.dat); Firefox 

(Temporary files, URL history, Cookies, Download history); Windows (Recycle Bin, Recent Documents, 

Temporary files, Log files); v¨ nhiԚu chҼҺng tr³nh kh§c trong Ľ· c· MS Office 2007. BӴn c· thԜ b֛ ch֙n 

nhֻng mֱc m¨ bӴn kh¹ng mu֝n x·a. 

 

ƴ Registry 

 

ChҼҺng tr³nh sԐ t֝i Ҽu h·a c§c kh·a registry cֳa Windows, nhԀn dӴng c§c registry b֗ l֣i ĽԜ khԂc phֱc, 

x·a Ľi c§c kh·a kh¹ng cӺn thiԒt. ņiԚu n¨y cֽc kȢ cӺn thiԒt cho Windows x¨i l©u ng¨y Ľang c· tri֓u chֵng 

chԀm lӴi. TrҼ֧c ti°n, bӴn ch֙n Scan for Issues ĽԜ CCleaner qu®t qua h֓ th֝ng. TiԒp theo, ch֙n Fix 

Selected Issues v¨ Fix All Selected Issues (khԂc phֱc tӸt cӶ) hay Fix Issues (sֹa tַng l֣i) ĽԜ chҼҺng tr³nh 

sֹa lӴi c§c l֣i li֓t k° b°n cӴnh. Ch¼ Ĩ, l¼c chҼҺng tr³nh h֛i bӴn c· sao lҼu registry ĽԜ ph¸ng sֽ c֝ th³ bӴn 

n°n ch֙n Yes ĽԜ lҼu lӴi m֥t file Registry Entries (file c· dӴng cc_ng¨y_gi֩.reg). C§c l֣i registry m¨ 

CCleaner c· thԜ sֹa ĽҼ֯c: File Extensions, ActiveX Controls, ClassIDs, ProgIDs, Uninstallers, Shared 

DLLs, Fonts, Help Files, Application Paths, Icons, v¨ c§c shortcut kh¹ng h֯p l֓. 

 

http://www.ccleaner.com/download


ƴ Tools 

 

Gi¼p bӴn g֭ b֛ sӴch sԐ c§c chҼҺng tr³nh Ľ« c¨i ĽԊt trong Windows hay t½y ch֙n cho c§c chҼҺng tr³nh 

kh֫i Ľ֥ng c½ng Windows. 

 

- Mu֝n g֭ b֛ m֥t chҼҺng tr³nh m¨ bӴn kh¹ng mu֝n x¨i nֻa th³ bӴn nhԂp Uninstall, sau Ľ· ch֙n chҼҺng 

tr³nh mu֝n g֭ v¨ nhԂp Run Uninstaller v¨ Ľ֯i cho chҼҺng tr³nh l¨m vi֓c. BӴn cȈng c· thԜ sֹa t°n phӺn 

mԚm (h֣ tr֯ tiԒng Vi֓t Unicode) hay x·a t°n phӺn mԚm Ľ· trong danh s§ch li֓t k° bԄng chֵc nŁng 

Rename Entry v¨ Delete Entry. Hay bӴn c· thԜ lҼu lӴi danh s§ch c§c phӺn mԚm Ľ« c¨i ĽԊt ĽԜ ti֓n cho vi֓c 

c¨i m֧i Windows bԄng c§ch nhԂp Save to text file. 

 

- ņԜ tԂt hoԊc x·a Ľi c§c ֵng dֱng kh֫i Ľ֥ng c½ng Windows, bӴn nhԂp Startup, ch֙n chҼҺng tr³nh v¨ nhԂp 

Delete Entry. 

 

ƴ Options 

 

Nhֻng t½y ch֙n n©ng cao cho Ccleaner hoӴt Ľ֥ng theo Ĩ cֳa bӴn. C· 5 thԎ tҼҺng ֵng v֧i 5 t½y ch֙n. 

 

- Settings: t½y ch֙n ng¹n ngֻ, cho hoԊc kh¹ng cho CCleaner chӴy c½ng Windows, tֽ Ľ֥ng cԀp nhԀt phi°n 

bӶn m֧i l¼c kh֫i Ľ֥ng Windows, c§c kiԜu x·a file (b³nh thҼ֩ng - Normal file deletion, hay an toàn - 

Secure file deletion)... 

 

ņԊc bi֓t, khi bӴn ch֙n v¨o Add ñRun CCleanerò... v¨ Add ñOpen  Cleaneròoption to Recycle Bin context 

menu th³ sԐ c· m֥t menu chu֥t phӶi ĽԜ CCleaner l¨m c§c c¹ng vi֓c t֝i Ҽu h֓ th֝ng nhanh ch·ng ch֕ v֧i 

m֥t c¼ nhԂp chu֥t v¨o Recycle Bin (s֙t r§c). 

 

- Cookies: gi¼p bӴn ch֙n nhֻng cookies cho c§c trang web n¨o giֻ lӴi v¨ c§c trang n¨o th³ x·a Ľi. BӴn 

h«y nhԂp ch֙n trang web b°n Cookies to Delete v¨ bӸm n¼t -> ĽԜ chuyԜn qua bên Cookies to Keep, hay 

chuyԜn ngҼ֯c lӴi bԄng n¼t <-. 

 

- Include: ĽԜ x·a c§c file hay folder m¨ Windows kh¹ng thԜ x·a ĽҼ֯c, bӴn h«y    nhԂp Add File/Folder 

ĽԜ ĽҼa v¨o v¨ nhԂp Remove Select ĽԜ b֛ Ľi. 

 

- Exclude: LoӴi trַ nhֻng folder, file, registry m¨ bӴn kh¹ng mu֝n x·a Ľi. 

 

- Advanced: c§c t½y ch֙n ĽԜ CCleaner hoӴt Ľ֥ng an to¨n nhҼ x·a c§c file tӴm cȈ hҺn 48 gi֩, kh¹ng cho 

hi֓n cӶnh b§o, hi֓n b§o c§o vԚ c§c file tӴm cֳa tr³nh duy֓t Internet Explorer, Firefox, lҼu lӴi c§c th¹ng tin 

c¨i ĽԊt sang file INI... 

 

Kinh nghi֓m cho thӸy CCleaner 2.2 hoӴt Ľ֥ng rӸt hi֓u quӶ tr°n Windows Vista Home Premium. H֓ 

th֝ng kh֫i Ľ֥ng v¨ chӴy nhanh, mҼ֯t hҺn rӸt nhiԚu sau khi sֹa c§c registry v¨ x·a r§c. ChҼҺng tr³nh ch֕ 

t֝n 740 KB RAM, nhҼng c¹ng dֱng lӴi t֛ ra mӴnh hҺn Your Uninstaller. 

 

(Theo NGUYΙN VŀN ņĎ - jackiedonguyen@gmail.com | KHPT ) 

H֙c tiԒng Anh tr°n m§y t²nh 

16.09.2010 20:21 



 

M§y t²nh l¨ c¹ng cֱ h֣ tr֯ rӸt ĽԂc lֽc v¨ hi֓u quӶ cho vi֓c h֙c ngoӴi ngֻ n·i chung, trong Ľ· c· tiԒng 

Anh. ThԀm ch² bӴn cȈng c· thԜ th¨nh c¹ng trong vi֓c tֽ h֙c tiԒng Anh v֧i m§y t²nh khi kh¹ng c· ĽiԚu 

ki֓n ĽԜ ĽԒn c§c l֧p h֙c. Ch֕ cӺn sԂm th°m tai nghe, ֡ Ľǫa DVD (nԒu chҼa c·) v¨ m֥t chҼҺng tr³nh h֙c 

tiԒng Anh ph½ h֯p v֧i tr³nh Ľ֥ cֳa m³nh. 

 

V֧i chiԒc m§y vi t²nh c· sԈn, bӴn c· thԜ tֽ h֙c v¨ ¹n luy֓n tiԒng Anh hoԊc c§c ngoӴi ngֻ kh§c sau nhֻng 

gi֩ h֙c tr°n l֧p, hoԊc ֫ trung t©m ngoӴi ngֻ; thԀm ch² c· thԜ tֽ h֙c trong trҼ֩ng h֯p kh¹ng c· ĽiԚu ki֓n 

tham gia c§c l֧p h֙c ngoӴi ngֻ. ņԜ l¨m ĽҼ֯c vi֓c n¨y, bӴn cӺn sԂm th°m tai nghe, ֡ Ľǫa DVD (nԒu máy 

t²nh chҼa c·) v¨ biԒt thao t§c tr°n m֥t s֝ chҼҺng tr³nh b֡ tr֯ cho c§c Ľǫa phӺn mԚm h֙c tiԒng Anh. 

 

S֝ h·a bŁng hoԊc chuyԜn Ľ֡i Ľǫa h֙c tiԒng Anh 

 

Vi֓c chuyԜn tַ h֙c Anh vŁn bԄng m§y cassette v¨ bŁng tַ sang m§y t²nh thҼ֩ng sԐ gi¼p ²ch bӴn chֳ Ľ֥ng 

và Ľ֭ t֝n th֩i gian d¸ t³m phӺn n֥i dung tr°n bŁng tַ. Mu֝n l¨m ĽiԚu n¨y, bӴn h«y h֛i mua Ľǫa h֙c tiԒng 

Anh c½ng n֥i dung v֧i bŁng cassette. Thֽc tԒ cho thӸy, phӺn l֧n c§c cֹa h¨ng b§n Ľǫa phӺn mԚm hoԊc 

nh¨ s§ch ĽԚu c· b§n loӴi Ľǫa CD Ľ« ĽҼ֯c s֝ h·a tַ bŁng cassette. NԒu kh¹ng t³m ĽҼ֯c Ľǫa tҼҺng ֵng v֧i 

bŁng cassette Ľang h֙c, bӴn c· thԜ tֽ s֝ h·a bԄng phӺn mԚm Free Hi-Q Recorder. 

 

Mua s֯i d©y n֝i d¨i khoӶng 1 m®t c· 2 ĽӺu cԂm 3 mm (3 ly) nhҼ ĽӺu cԂm headphone. CԂm m֥t ĽӺu v¨o 

ng» Line in (thҼ֩ng c· m¨u xanh dҼҺng, xanh ĽԀm) cֳa m§y t²nh, cԂm ĽӺu c¸n lӴi v¨o ng» headphone 

(hoԊc Line out) cֳa m§y cassette. Download phӺn mԚm thu ©m mi֑n ph² Free Hi-Q Recorder tӴi 

www.roemersoftware.com/free-sound-recorder.html. C¨i ĽԊt v¨ chӴy Hi-Q Recorder, bӸm n¼t 

Options, bӸm ¹ Input Source ch֙n Line in, bӸm n¼t Select ĽԜ ch֙n thҼ mֱc lҼu file, bӸm OK. Sau Ľ·, 

bӸm n¼t Record r֟i bӸm n¼t Play tr°n m§y cassette ĽԜ bԂt ĽӺu thu ©m. 

 

C¸n nԒu bӴn Ľang d½ng m§y Ľǫa (mini disc) ĽԜ h֙c tiԒng Anh bԄng c§c Ľǫa Audio CD (m֫ Ľǫa trong cֹa 

s֡ My Computer th³ ch֕ thӸy c§c file c· dӴng *.cda v¨ dung lҼ֯ng v¨i byte), bӴn c· thԜ chuyԜn n· th¨nh 

file *.mp3 v¨ lҼu v¨o Ľǫa cֵng m§y t²nh ĽԜ ti֓n sֹ dֱng, kh¹ng phӶi kh֡ cֽc v³ t³nh trӴng Ľǫa CD b֗ trӺy, 

xҼ֧c m¨ kh¹ng Ľ֙c ĽҼ֯c. C§ch ĽҺn giӶn nhӸt ĽԜ thֽc hi֓n vi֓c n¨y l¨ d½ng phӺn mԚm mi֑n ph² Free 

Audio CD To MP3 Converter (http:/ /dvdvideosoft.com/download/FreeAudioCDToMP3-

Converter.exe). 

 

M֫ v¨ ĽiԚu khiԜn file ©m thanh 

 

Sau khi c· file ©m thanh h֙c tiԒng Anh, bӴn d½ng m֥t chҼҺng tr³nh c· t²nh nŁng m֫ file ©m thanh ĽԜ m֫ 

n·. Kinh nghi֓m cho thӸy, chҼҺng tr³nh Winamp (download file c¨i ĽԊt tӴi 

www.filehippo.com/download_winamp) d֑ d½ng hҺn nhiԚu chҼҺng tr³nh kh§c, nh֩ c· nhiԚu ph²m tԂt 

song song v֧i d½ng chu֥t. ChԆng hӴn, bӴn bӸm ph²m mȈi t°n sang phӶi, tr§i ĽԜ vҼ֯t qua ĽoӴn Ľang nghe 

hoԊc tr֫ lӴi ĽoӴn trҼ֧c Ľ·; hoԊc cŁn cֵ v¨o ch֕ s֝ th֩i gian v¨ thanh trҼ֯t th֩i gian hiԜn th֗ tr°n cֹa s֡ 

chҼҺng tr³nh nghe nhӴc ĽԜ bӸm chu֥t v¨o v֗ tr² cӺn nghe. 

http://www.roemersoftware.com/free-sound-recorder.html
http://dvdvideosoft.com/download/FreeAudioCDToMP3-Converter.exe
http://dvdvideosoft.com/download/FreeAudioCDToMP3-Converter.exe
http://www.filehippo.com/download_winamp


 

PhӺn mԚm h֙c tiԒng Anh v¨ mӴng Internet 

 

Hi֓n nay, c§c cֹa h¨ng b§n Ľǫa phӺn mԚm v¨ nh¨ s§ch b§n kh§ nhiԚu loӴi Ľǫa h֙c tiԒng Anh d¨nh cho m֙i 

lֵa tu֡i, cӸp Ľ֥. BӴn c· thԜ ch֙n c§c Ľǫa phӺn mԚm gi¼p h֙c tiԒng Anh do c§c c¹ng ty phӺn mԚm trong 

nҼ֧c sӶn xuӸt, gi§ khoӶng tַ 16.000 - 50.000 Ľ֟ng. HoԊc ch֙n c§c Ľǫa phӺn mԚm h֙c tiԒng Anh cֳa nҼ֧c 

ngo¨i nhҼ Lets go, English for children, English for Kids, English in Focus for Children, Kidspeak, H֙c 

tiԒng Anh cho trԎ em qua c§c b¨i h§t... 

 

ņ֝i v֧i cӸp Ľ֥ cao hҺn, Ľǫa phӺn mԚm English Study v֧i giao di֓n tiԒng Vi֓t sԐ l¨ sֽ lֽa ch֙n ĽӺu ti°n 

cho bӴn. ņǫa n¨y sԐ gi¼p bӴn h֙c t֝t tַ vֽng, ngֻ ph§p, nghe v¨ l¨m b¨i tԀp, Ľ֟ng th֩i c¸n tiԒp cԀn ĽҼ֯c 

v֧i 2 gi§o tr³nh tiԒng Anh n֡i tiԒng l¨ Headway v¨ Streamline. ֪ cӸp Ľ֥ cao hҺn nֻa, bӴn c· thԜ mua b֥ 

Ľǫa Langmaster ĽԜ h֙c hoԊc Ľǫa k¯m theo các sách giáo trình. 

 

Khi mua, bӴn cӺn h֛i r» xem Ľǫa Ľ֗nh mua c· d½ng ĽҼ֯c v֧i h֓ ĽiԚu h¨nh Windows m¨ bӴn Ľang d½ng 

hay kh¹ng, thֽc tԒ m֥t s֝ Ľǫa h֙c tiԒng Anh ph§t h¨nh Ľ« l©u n°n kh¹ng thԜ d½ng tr°n c§c h֓ ĽiԚu h¨nh 

Ľ֩i m֧i nhҼ Windows Vista, 7. 

 

Các phӺn mԚm h֙c tiԒng Anh thҼ֩ng y°u cӺu bӴn b֛ Ľǫa v¨o ֡ Ľǫa CD, DVD khi sֹ dֱng. Do vԀy nԒu 

kh¹ng mu֝n thӸy th¹ng b§o n¨y, bӴn c· thԜ d½ng chҼҺng tr³nh tӴo ֡ Ľǫa CD Ӷo nhҼ Virtual Drive, 

Alcohol, Virtual CD, CDSpace... r֟i copy tӸt cӶ c§c file tr°n Ľǫa h֙c tiԒng Anh v¨o Ľǫa Ӷo trҼ֧c khi tiԒn 

h¨nh c¨i ĽԊt v¨o m§y t²nh. 
 

Tr°n m§y t²nh, bӴn kh¹ng ch֕ c· thԜ nghe m¨ c· thԜ xem c§c t³nh hu֝ng giao tiԒp bԄng c§c Ľǫa VCD, 

DVD. Kh¹ng ch֕ c· vԀy, bӴn c¸n c· thԜ d½ng b¨n ph²m ĽԜ ñn·i chuy֓nò v֧i m§y t²nh th¹ng qua chҼҺng 

tr³nh chat Ӷo, c§c game gh®p hoԊc t³m tַ tiԒng Anh c· nghǫa, tra tַ ĽiԜn bԄng b֥ tַ ĽiԜn LӴc Vi֓t, tr°n 

mӴng Internet..., hoԊc h֙c tַ vֽng ngay tr°n c§c cֹa s֡ chҼҺng tr³nh bԄng chҼҺng tr³nh ClicknSee, chֵc 

nŁng tra nhanh tַ cֳa tַ ĽiԜn LӴc Vi֓t (bӸm chu֥t phӶi, hoԊc giֻa ph²m Shift r֟i bӸm chu֥t phӶi l°n tַ 

tiԒng Anh ĽԜ biԒt nghǫa cֳa n·). 

 

Ngo¨i ra, bӴn c¸n c· thԜ t³m v¨ khai th§c kho t¨i nguy°n h֙c tiԒng Anh tr°n mӴng Internet, truy cԀp trang 

web www.google.com v¨ g» cֱm tַ kh·a ñlearning Englishò trong cԊp dӸu nh§y k®p v¨ bӸm Enter. HoԊc 

truy cԀp trang web www.ctu.edu.vn/centers/cfl/soft/index.htm ĽԜ tӶi. 

 

(Theo Th©n TiΔn Nam | KHPT ) 

Chat c· h³nh v¨ g֙i Ľi֓n thoӴi v֧i Gmail 

16.09.2010 20:18 

 

http://www.google.com/
http://www.ctu.edu.vn/centers/cfl/soft/index.htm


V֧i sֽ h֣ tr֯ cֳa m֥t c¹ng cֱ nh֛ g֙n, tַ trong Gmail bӴn c· thԜ g֙i Ľi֓n thoӴi ĽԒn m֥t s֝ n¨o Ľ· (hi֓n 

tӴi l¨ mi֑n ph² ĽԒn M׃ v¨ Canada), hoԊc chat c· h³nh khi hai m§y t²nh ĽԚu Ľ֟ng th֩i ĽŁng nhԀp v¨o t¨i 

khoӶn Gmail. Vi֓c b֡ sung t²nh nŁng video chat ngay tr°n tr³nh duy֓t ֫ trang Gmail v¨ g֙i Ľi֓n ĽԒn c§c 

s֝ Ľi֓n thoӴi tr°n khԂp thԒ gi֧i, Gmail Ľ« m֥t lӺn nֻa khԆng Ľ֗nh sֵc mӴnh v¨ v֗ tr² h¨ng ĽӺu cֳa m³nh. 

 

Chat c· h³nh giֻa 2 t¨i khoӶn Gmail 

TrҼ֧c nay, bӴn c· thԜ chat giֻa 2 t¨i khoӶn Gmail thԀt d֑ ngay tr°n tr³nh duy֓t, tuy nhi°n nhҼ vԀy vӾn 

c¸n kh§ ĽҺn Ľi֓u. Xu hҼ֧ng chat c· h³nh tr°n Skype v¨ Yahoo! Messenger cȈng l¨ m֥t ĽiԜm hay m¨ 

Google Ľ« triԜn khai tr°n Gmail. ņԜ sֹ dֱng chֵc nŁng n¨y, bԂt bu֥c 2 m§y t²nh ĽԚu phӶi ĽŁng nhԀp v¨o 

t¨i khoӶn Gmail Ľ« Ľ֟ng Ĩ kԒt n֝i Chat v֧i nhau v¨ phӶi c½ng c¨i ĽԊt phӺn mԚm h֣ tr֯ tr°n Gmail. C¹ng 

cֱ h֣ tr֯ ĽҼ֯c cung cӸp tӴi http://tinyurl.com/lythanh709 (554 KB, y°u cӺu kԒt n֝i Internet khi c¨i ĽԊt), 

tҼҺng th²ch v֧i m֙i tr³nh duy֓t v¨ h֓ ĽiԚu h¨nh Windows. 

 
 

Sau khi c¨i ĽԊt th¨nh c¹ng, bӴn ch֕ vi֓c r° chu֥t ĽԒn t°n ngҼ֩i bӴn trong danh s§ch bӴn b¯, ch֙n Video & 

more, bӸm v¨o Video Chat ĽԜ tr¸ chuy֓n v֧i nhau ngay tr°n tr³nh duy֓t v֧i h³nh Ӷnh trên webcam và âm 

thanh s֝ng Ľ֥ng. 

 

G֙i Ľi֓n tַ Gmail ĽԒn Ľi֓n thoӴi 

ņ©y l¨ m֥t t²nh nŁng hֵa hԌn tӴo n°n m֥t sֽ Ľ֥t ph§ cho Gmail khi ngҼ֩i d½ng c· thԜ thֽc hi֓n cu֥c g֙i 

tַ t¨i khoӶn Gmail ĽԒn s֝ Ľi֓n thoӴi n¨o Ľ· v֧i gi§ rԎ v¨ kh¹ng cӺn m֥t chiԒc Ľi֓n thoӴi hay SIM card. 

Tuy nhi°n, hi֓n tӴi d֗ch vֱ ch֕ §p dֱng cho cu֥c g֙i ĽԒn c§c nҼ֧c Canada  v¨ M׃ (hi֓n tӴi l¨ mi֑n ph²).  

 



ņԜ quay s֝, bӴn bӸm v¨o t°n Call phone (t½y ch֙n n¨y hiԜn th֗ dҼ֧i dӴng m֥t ngҼ֩i bӴn trong danh s§ch 

li°n h֓ Gmail cֳa bӴn sau khi Ľ« c¨i ĽԊt c¹ng cֱ h֣ tr֯ ֫ tr°n). H֥p thoӴi hi֓n ra cho ph®p bӴn ch֙n qu֝c 

gia sԐ ĽҼ֯c g֙i ĽԒn (nhԄm lӸy ĽӺu s֝ ch²nh x§c) v¨ bӴn nhԀp s֝ Ľi֓n thoӴi v¨o bԄng c§ch g» v¨o ¹ Search 

or dial, hay bӸm ch֙n v¨o c§c s֝ b°n dҼ֧i. Cu֝i c½ng, bӸm Call ĽԜ g֙i. LҼu Ĩ: sֹ dֱng d֗ch vֱ n¨y, 

Google c¸n cung cӸp cho bӴn t²nh nŁng quӶn lĨ cu֥c g֙i cֱ thԜ v¨ ch²nh x§c. 

 

(Theo Phͧm LĨ Th¨nh (phamlythanh@gmail.com) | KHPT ) 

6 c¹ng cֱ kԒt n֝i wi-fi 

16.09.2010 20:07 

 

  

BӶn th©n Windows cȈng c· c· sԈn c¹ng cֱ gi¼p bӴn kԒt n֝i Internet qua s·ng wi-fi, tuy nhi°n nԒu mu֝n 

sֹ dֱng loӴi kԒt n֝i kh¹ng d©y n¨y m֥t c§ch hi֓u quӶ v¨ chuy°n nghi֓p hҺn, bӴn n°n c¨i th°m m֥t v¨i 

c¹ng cֱ h֣ tr֯... 

  

Ng¨y nay, nԒu c· m֥t m§y t²nh x§ch tay, bӴn ho¨n to¨n c· thԜ kԒt n֝i Internet ֫ bӸt cֵ Ľ©u, mi֑n l¨ c· 

sóng wi-fi. ņ©y l¨ m֥t thuԀn l֯i rӸt l֧n cho vi֓c th¹ng tin, li°n lӴc cȈng nhҼ kinh doanh. VӸn ĽԚ l¨ 

Windows kh¹ng cung cӸp c§c c¹ng cֱ t֝t nhӸt cho vi֓c sֹ dֱng wifi. MԊc d½ Windows cho ph®p bӴn t³m 

kiԒm v¨ kԒt n֝i v֧i c§c mӴng gӺn Ľ·, nhҼng lӴi kh¹ng gi¼p ĽҼ֯c g³ nhiԚu cho bӴn khi mu֝n t³m hiԜu 

th¹ng tin chi tiԒt vԚ m֣i mӴng, khԂc phֱc sֽ c֝ mӴng, bӶo ĽӶm an ninh mӴng, hay mu֝n biԒn m§y t²nh 

x§ch tay cֳa m³nh th¨nh m֥t ĽiԜm kԒt n֝i wi-fi... 

  

B¨i viԒt n¨y xin gi֧i thi֓u 6 c¹ng cֱ h֣ tr֯, cung cӸp cho bӴn tӸt cӶ nhֻng ĽiԚu tr°n, v¨ c¸n nhiԚu hҺn 

nֻa. NŁm trong s֝ sӶn phӼm n¨y l¨ mi֑n ph², 1 sӶn phӼm c· thu ph², tuy nhi°n bӴn c· thԜ d½ng thֹ n·. 

  

1. InSSIDer 
  



 
  

InSSIDer cֳa h«ng MetaGeek l¨ m֥t c¹ng cֱ tuy֓t v֩i cho vi֓c t³m kiԒm c§c mӴng wi-fi trong phӴm vi 

cֳa m§y t²nh v¨ thu thԀp rӸt nhiԚu th¹ng tin kh§c. N· cȈng hֻu ²ch cho vi֓c khԂc phֱc sֽ c֝ v֧i mӴng 

wi-fi cֳa ri°ng bӴn. 

  

Khi mӴng wi-fi ĽҼ֯c t³m thӸy bԄng inSSIDer, n· cung cӸp cho bӴn Ľ֗a ch֕ MAC cֳa router, t°n nh¨ sӶn 

xuӸt router, k°nh m¨ n· sֹ dֱng, Ľ֗nh danh d֗ch vֱ hoԊc t°n mӴng c¹ng c֥ng, phҼҺng ph§p bӶo mԀt ĽҼ֯c 

sֹ dֱng, t֝c Ľ֥ mӴng, v¨ nhiԚu th¹ng tin kh§c... Ngo¨i ra, n· sԐ hiԜn th֗ cҼ֩ng Ľ֥ t²n hi֓u hi֓n tӴi cֳa 

mӴng, cȈng nhҼ cҼ֩ng Ľ֥ t²n hi֓u theo th֩i gian cֳa ch²nh n·. 

BӴn sԐ sֹ dֱng phӺn mԚm n¨y ĽԜ khԂc phֱc sֽ c֝ mӴng wi-fi nhҼ thԒ n¨o?  

  

NԒu thӸy rԄng mӴng Ľang sֹ dֱng c· c½ng m֥t k°nh truyԚn v֧i c§c mӴng gӺn Ľ· c· cҼ֩ng Ľ֥ t²n hi֓u cao 

hҺn, bӴn n°n thay Ľ֡i k°nh truyԚn mӴng cֳa m³nh, ĽiԚu Ľ· sԐ gi¼p giӶm xung Ľ֥t. HӺu hԒt c§c router cho 

ph®p bӴn l¨m ĽiԚu n¨y. BӴn cȈng c· thԜ sֹ dֱng phӺn mԚm ĽԜ ph§t hi֓n ñv½ng chԒtò, l¨ nҺi kh¹ng c· kԒt 

n֝i wi-fi t֝t. 

  

InSSIDer l¨ phӺn mԚm mi֑n ph², tҼҺng th²ch v֧i c§c Windows XP/Vista/7 (32 v¨ 64-bit). Download tӴi 

http://www.metageek.net/products/inssider. 

  

2. Xirrus Wi -Fi Inspector 
  

 
  

http://www.metageek.net/products/inssider

